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Bienvenido a tu curso 
Revit Architecture Fundamentos 

  

Al terminar este curso conocerás el concepto de BIM y como la tecnología de 

Revit se enfoca en esta metodología y cómo Modelar edificios de formas básicas 

utilizando los elementos arquitectónicos incluidos en Revit.  

Podrás realizar modificaciones básicas a elementos arquitectónicos y adaptarlos a 

los requisitos de proyecto y modificar la estructura de los componentes básicos de 

un modelo arquitectónico. ￼ 

 

Preguntas frecuentes sobre nuestros Cursos Presenciales  

 

Preguntas frecuentes sobre nuestros Cursos Online 

 

https://youtu.be/ZsW2LRKwdzE
https://youtu.be/jpGtRSkx8nE
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Capítulo 1 
 

Introducción 

 
Conceptos BIM 
 
Antes de comenzar con el diseño, es necesario entender cómo es que Revit Architecture 
maneja la información. 
 
Cada proyecto de construcción contiene una descripción completa del edificio y toda la 
información que se necesita para representar las vistas en 2D y 3D, además de los 
reportes. La información es almacenada en una base de datos. Todas las vistas del 
modelo; plantas, secciones, láminas de impresión, usan la misma base de datos. 
 
Building Information Modeling (BIM) 
 
Tradicionalmente los modelos de construcción han sido creados utilizando sistemas CAD. 
La información relacionada con la documentación de los proyectos ha sido agregada 
creando planos adicionales, notas y otros documentos con especificaciones.  Con los 
avances de la tecnología CAD, algunos de estos procesos han sido automatizados, sin 
embargo, la documentación del proyecto aún no se maneja de acuerdo con los 
parámetros que debe tener un proyecto de construcción. 
 
Revit Architecture es un software modelador, que representa el diseño con una serie de 
elementos inteligentes tales como muros, ventanas, puertas, vistas etc. Estos objetos y 
elementos tienen atributos paramétricos. El motor de cambios paramétricos de Revit 
coordina automáticamente los cambios realizados en cualquier sitio: en vistas de modelo, 
planos de dibujo, tablas de planificación, secciones y planos. BIM aporta información 
sobre el diseño, la envergadura, las cantidades y las fases de un proyecto cuando se 
necesita. 
 
 
Asociatividad bidireccional 
 
Una de las herramientas clave de Revit Architecture es que los cambios en el proyecto 
son bidireccionales, esto asegura que los cambios realizados en cualquier parte del 
diseño son inmediatamente reflejados en todas las partes asociadas. 
Asociatividad bidireccional es entonces la habilidad de Revit para coordinar los cambios 
hechos en cualquier vista, con la base de datos y las demás vistas. Por ejemplo, el 
cambio de la dimensión de una pared es reflejada en todos los elementos tales como 
ventanas, puertas, plafones etc., que están influenciados por el cambio en la dimensión 
de la pared. 
 
Ejemplos de asociatividad bidireccional: 
 

• Asociar una pared con el Techo. Al asociar estos elementos, la pared 
automáticamente cambia su geometría para ajustarse al techo. Este cambio se ve 
reflejado automáticamente en todas las vistas y reportes que incluyen la pared. 
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Parametría 
 
El termino paramétrico se refiere a la “relación existente entre elementos del diseño”, 
estas relaciones son creadas automáticamente por el software o también pueden ser 
definidas por el usuario. 
 
Ejemplos de parametría: 
 

• Se puede especificar que el lado exterior del marco de una puerta se encuentre a una 
distancia específica del extremo de la pared. Entonces cuando la pared es 
desplazada, la puerta conserva la distancia especificada, desplazándose junto con la 
pared si es necesario. 

 
 
 

Interfaz de Usuario 
 
La interfaz de Revit Architecture está pensada para facilitar las tareas del usuario. Con 
sólo unos clics del ratón puede modificarla del modo más conveniente para usted. Por 
ejemplo, puede elegir entre tres configuraciones distintas de visualización para la Cinta de 
opciones. También puede visualizar varias vistas de proyecto simultáneamente o 
colocarlas en capas para ver sólo la que se encuentre en la capa superior. 
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La interfaz de Revit organiza de la siguiente manera: 
 
Funciones de menú de cinta (Ribbon) 
 
Inicio de Revit / Home (1) 
Se despliega al abrir el programa, donde se observan las opciones para abrir o crear 
archivos de proyecto, familias o acceder a las opciones de ayuda. 
 

 
 
 



10 
 

File Tab / Pestaña Archivo (2) 
permite acceder a acciones habituales de archivo como Nuevo, Abrir y Guardar. También 
permite administrar los archivos mediante herramientas más avanzadas, como Exportar y 
Publicar. 
 

 
 
Quick Access Bar / Barra de acceso rápido (3) 
Contiene los comandos para deshacer (Undo) y rehacer (Redo), abrir, y grabar proyectos, 
el comando para selección de objetos, las opciones para crear vistas 3D, perspectivas y 
caminatas. 
 

 
 
Para activar o desactivar funciones de Quick Acces Bar: 
 

1. Hacer clic sobre el icono desplegable  
2. Seleccionar el comando  

 
InfoCenter / Centro de información (4) 
 
Proporciona acceso a las ayudas de Revit 
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Options Bar / Barra de opciones (5) 
 
Dependiendo la orden que se esté ejecutando en esta barra aparecerán las opciones 
específicas que pueden utilizarse para dicha orden 
 

 
 
Type Selector / Selector de tipos (6)  
 
 En el Type Selector se muestran los diferentes tipos de elementos cargados en el 
proyecto (familias) y que están listos para usarse, por ejemplo, si se selecciona la orden 
muro, el type selector desplegará todos los tipos de muros disponibles y cargados en el 
proyecto. 
 
Propiedades / Properties Palette (7) 
 
La paleta Propiedades es un cuadro de diálogo no modal que permite visualizar y 
modificar los parámetros que definen las propiedades de los elementos. 
 
Para activar la paleta de propiedades: 
 

1. Escoger pestaña View => User interface => Properties o teclear las letras PP 
 
Normalmente, la paleta Propiedades se mantiene abierta durante una sesión de Revit 
para que el usuario pueda efectuar las acciones siguientes:  
 

• Seleccionar el tipo de elemento que va a colocar en el área de dibujo o cambiar el 
tipo de los elementos colocados mediante el selector de tipo.  

• Ver y modificar las propiedades del elemento que se va a colocar o de los 
elementos seleccionados en el área de dibujo.  

• Ver y modificar las propiedades de la vista activa.  

• Acceder a las propiedades de tipo que se aplican a todos los ejemplares de un tipo 
de elemento.  

 
 
Propiedades de vista 
 
Si no hay ninguna herramienta de colocación de elementos activa ni ningún elemento 
seleccionado, la paleta muestra las propiedades de ejemplar de la vista activa.  Modifique 
las propiedades de la vista para cambiar la escala de vista, el nivel de detalle, el estilo visual, 
la orientación y otras propiedades de la vista. 
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Otras propiedades de vista que se pueden observar en la paleta de propiedades son: 
 
Display Model: Oculta el modelo en la vista de detalle. El parámetro Normal muestra 
todos los elementos normalmente. Es para vistas que no son de detalle. El parámetro No 
visualizar muestra solo los elementos específicos de la vista de detalle. Estos elementos 
comprenden líneas, regiones, cotas, texto y símbolos. Los elementos del modelo no se 
muestran. El parámetro Tramado muestra todos los elementos específicos de vista de 
modo normal y los elementos de modelo como Definir configuración de 
Subyacente/Tramado. Puede utilizar los elementos de modelo mostrados como tramado 
como referencia para trazar líneas, y realizar acotaciones y alineaciones. 
 
Parts Visibility: Especifica si la vista muestra las piezas, el elemento original del que se 
derivan o ambos. 
 
Orientation: Alterna la orientación del proyecto en la vista entre el norte del proyecto y el 
norte real. 
  
Wall Join Display: Define el comportamiento por defecto de la limpieza de uniones de 
muro. Si define esta propiedad en Limpiar todas las uniones de muro, Revit limpia 
automáticamente todas las uniones. Si la define en Limpiar el mismo tipo de uniones de 
muro, Revit solo limpia las uniones de muro del mismo tipo de muro. Si une distintos tipos 
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de muros, Revit no limpia las uniones entre ellos. Puede modificar esta configuración con 
la herramienta Editar uniones del muro. 
 
Discipline: Determina cómo se muestran los elementos específicos de una disciplina en 
la vista. Este parámetro también puede utilizarse para organizar vistas en el Navegador 
de proyectos. 
 
Plantilla de vista: Identifica la plantilla de vista asignada a la vista. Los cambios 
posteriores en la plantilla de vista afectarán a la vista. 
 
View Range: En las propiedades de vista de una vista de plano, puede configurar el 
rango de la vista. Con esta opción puede controlar los planos geométricos específicos que 
definen los contornos de cada vista. Estos límites se establecen definiendo el plano 
exacto de corte, así como los planos de delimitación superior e inferior. 
 
Associate Level: El nivel asociado con la vista de plano. Es una propiedad de solo 
lectura. 
 
Scope box: Si dibuja una caja de referencia en una vista, puede asociar la región de 
recorte de la vista con esa caja de referencia, de modo que la región de recorte esté 
visible y coincida con la extensión de la caja de referencia. Esta propiedad está disponible 
solo para las vistas de plano, alzado y sección. Al seleccionar un valor de caja de 
referencia para esta propiedad, las propiedades Región de recorte y Región de recorte 
visible se convierten en propiedades de solo lectura. 
 
Phase Filter: El filtro de fases aplicado a la vista. 
 
Phase: La fase específica de la vista. Junto con Filtro de fases, determina los 
componentes del modelo (en lo que respecta a la fase) que son visibles en la vista y el 
modo de mostrarse gráficamente. Cuando se crean otros componentes de un modelo en 
una vista, estos componentes adoptan la fase de la vista como su fase de creación. 
 

 

Propiedades de objetos 
 
Si hay un elemento seleccionado la paleta muestra las propiedades del elemento. 
También es posible acceder a las propiedades de ejemplar de una vista seleccionándola 
en el Navegador de proyectos.  
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1. Selector de tipos: Identifica el tipo de familia que está seleccionado y proporciona 
un menú desplegable que permite cambiar de tipo. Cuando hay una herramienta 
de colocación de elementos activa, o al seleccionar elementos del mismo tipo en el 
área de dibujo, el Selector de tipo aparece en la parte superior de la paleta 
Propiedades. 

 
2. Al hacer clic en el Selector de tipo, se muestra un campo de búsqueda. Escriba las 

palabras clave en el campo de búsqueda para encontrar rápidamente el tipo de 
contenido que necesita. 
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3. Filtro de propiedades: Debajo del selector de tipo hay un filtro que identifica la 
categoría de los elementos que va a colocar una herramienta o la categoría y el 
número de elementos seleccionados en el área de dibujo. Si se seleccionan varios 
tipos o categorías, la paleta solo muestra las propiedades de ejemplar comunes a 
todos los elementos. 

 

 
 

4. Botón editar tipo: A menos que se seleccionen elementos de distintos tipos, el 
botón Editar tipo abre un cuadro de diálogo que permite visualizar y modificar las 
propiedades de tipo del elemento seleccionado (o las propiedades de la vista, 
según se haya configurado el filtro de propiedades). 

 
5. Propiedades de ejemplar: En la mayoría de los casos (vea las excepciones en la 

nota que encontrará más abajo), la paleta Propiedades muestra propiedades de 
ejemplar tanto modificables como de solo lectura (sombreadas). Las propiedades 
son de sólo lectura cuando su valor se calcula o asigna automáticamente mediante 
el software o depende de la configuración de otra propiedad. 

 
Project Browser / Navegador de proyectos (8) 
 
El Navegador de proyectos muestra una jerarquía lógica de todas las vistas, tablas de 
planificación, planos, grupos y otras partes del proyecto actual. Al expandir o contraer una 
rama, aparecen o se ocultan los elementos de niveles inferiores. 
 
El Project Browser consta de varias secciones o grupos que guardan las vistas que se 
generan en el proyecto, algunos de estos grupos son: 
 

• Floor plans (vistas de planta): se despliegan todos los niveles de los edificios 
(plantas) 

• Ceiling Plans (vistas de techo): muestra las vistas de entre piso. 

• 3D View (vistas 3D): despliega las Vistas 3D grabadas 

• Elevations (fachadas o elevaciones): muestra las vistas de elevación del edificio 
desde Norte, Sur, Este y Oeste. 

• Schedule/Quantities (listados de cuantificación y materiales): guarda las tablas de 
cuantificación y materiales. 

• Sheets (planos): guarda las vistas de láminas de impresión creadas en el 
proyecto 

• Families (Familias): muestra el listado de familias que están cargadas en el 
proyecto 

• Groups (Grupos): guarda los grupos creados en el proyecto 
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A medida que se van agregando vistas al proyecto, como por ejemplo secciones, detalles, 
caminatas, etc. Se crearán nuevas secciones que guardan la información de estas vistas 
en el Project Browser. 
 

 
 
Para activar y desactivar el Project Browser: 

1. Escoger pestaña View => Panel Windows =>  

2. Activar o desactivar la opción Project Browser  
 
 
Status Bar / Barra de estatus (9) 
 
La barra de estado ofrece consejos y sugerencias sobre qué hacer. Cuando se resalta un 
elemento o un componente, la barra de estado muestra el nombre de la familia y el tipo.  
La barra de estado se encuentra en la parte inferior de la ventana de la aplicación.  
 

 
 
La barra de herramientas de progreso “progress bar”  se muestra al lado izquierdo de la 
barra de herramientas de estatus cuando un archivo muy grande se esta abriendo e indica 
el porcentaje de carga del archivo 
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Al lado derecho de la barra de estatus se encuentran las casillas Workset y Design 
options (opciones de diseño), desde las cuales se puede cambiar de forma rápida y 
directa de workset y opción de diseño.  
 

 
 
Complementan las opciones de la barra de estatus las opciones: 
 

 
 

• Select Links : permite seleccionar un archivo vinculado y sus elementos 

• Select Underlay elements : permite seleccionar elementos que están debajo 
de la vista 

• Select Pinned elements : permite seleccionar elementos que están bloquados 

• Select Element by face : permite seleccionar elementos por caras 

• Drag elements on Selection : activada permite desplazar elementos sin que 
los haya seleccionado previamente (al estar resaltados se podrán desplazar) 

   
Control Bar / Barra de controles (10) 
 
La barra de controles de vista permite acceder rápidamente a funciones relacionadas con 
la vista actual. 
 

 
 
Las funciones de la barra de controles son: 
 
Escala: La escala de vista es el sistema proporcional utilizado para representar objetos 
en un dibujo. Puede asignar una escala distinta a cada vista en un proyecto. También 
puede crear escalas de vista personalizadas.  
 
Para asignar una escala de vista, 
 

1. Haga clic sobre el icono que muestra la escala de la vista. 
2. Seleccione una escala en la barra de controles de vista. 
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3. También puede cambiar la escala de una vista en la paleta de propiedades  
 

             
 
 
Nivel de detalle: El nivel de detalle afecta como se visualiza la geometría de los 
elementos en la vista activa. Por ejemplo, en la figura se muestra la misma puerta, pero 
con distintos niveles de detalle: 
 

• En la primera imagen, la puerta tiene el nivel de detalle básico llamado Coarse, el 
cual solo muestra el panel y marco. 

• En la segunda imagen, la puerta tiene el nivel de detalle Medium, que además de 
marco y paneles despliega las ventanas. 

• En la tercera imagen, puerta tiene el nivel de detalle fino, que muestra todos los 
elementos adicionales, tales como manijas. 
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Para aplicar niveles de detalles en una vista: 
 

1. En la barra de herramientas de control, hacer clic sobre el botón Detail Level  
 

 
 

2. Escoger el nivel de detalle requerido. 
 
Visual Styles (Estilos visuales): Puede especificar múltiples estilos de gráficos para una 
vista de proyecto. Los estilos de gráficos de modelo se agrupan en opciones de gráficos 
de modelo y de visualización de gráficos. Las opciones de gráficos de modelo son: 
  

• Estructura alámbrica: El estilo Estructura alámbrica muestra la imagen del 
modelo con todos los bordes y líneas dibujados, pero sin las superficies. 

 

 
• Línea oculta: muestra la imagen con todos los bordes y líneas dibujados, excepto 

los obstruidos por superficies.   
 

 
• Sombreado: muestra la imagen en modo sombreado y permite mostrar luz 

indirecta y sus sombras. 



20 
 

 
 

• Colores consistentes: muestra la imagen con todas las superficies sombreadas 
según la configuración de color de sus materiales. Este estilo mantiene un color de 
sombreado coherente para que los materiales se muestren siempre con el mismo 
color, independientemente de su orientación con respecto al origen de luz.  

 

  
 

• Sombreado realístico: muestra las apariencias de material en vistas editables. Al 
girar el modelo, las superficies se muestran como aparecerían en distintas 
condiciones de iluminación. La iluminación artificial no se muestra en las vistas 
realistas. 
 

 
 

• Ray Trace: es un modo de renderización fotorrealista que permite aplicar zoom y 
encuadrar el modelo. Cuando se utiliza este estilo visual, la renderización del 
modelo comienza en una resolución baja, pero se aumenta rápidamente la 
fidelidad para que sea más fotorrealista. 
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Para activar los estilos visuales: 
 

1. En la barra de herramientas de control, hacer clic sobre el botón Visual Style. 
 

 
 

2. Escoger el tipo de estilo visual requerido 
 

Sun   Shadows  (Sol – sombras): Activa o desactiva la visibilidad del camino de 
sol y las sombras vista en una vista. Al activar o desactivar el camino de sol o las sombras 
en una vista, las otras vistas no se ven afectadas.  
 
Las vistas 3D tienen más elementos que proyectan sombras que las vistas 2D, de forma 
que generan mucha más información sobre iluminación natural, requisitos de sombreado, 
posibilidades de diseño solar pasivo y posibilidades de energía renovable.  
 
Para activar la luz de sol y la sombra 
 

1. En la barra de herramientas de controles de vista hacer clic sobre icono , para 
desplegar las ociones del comando. 

 

 
 

2. En la barra de herramientas de controles de vista hacer clic sobre icono . 
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Rendering Dialog / Mostrar cuadro dialogo Render: Permite configurar los parámetros 
que controlan la iluminación, la exposición, la resolución, el fondo y la calidad de la 
imagen, para generar un Render de la vista. 
 

Crop View  – Show Crop Region / Recorte de vista – Mostrar recorte de 
región: La región de recorte define los contornos de una vista de proyecto, con la opción 
Show crop región activa o desactiva la visibilidad de la región que requiere ocultar y 
mostrar. 
 

Unlocked 3D View : Bloquea la orientación de una vista 3D para etiquetar elementos 
y añadir notas clave en la vista. 
 
Temporary Hide/Isolate (Ocultar/Aislar objetos temporalmente): Ocultar o aislar 
elementos o categorías de elementos temporalmente puede resultar de gran utilidad si 
desea ver o editar sólo algunos elementos de una categoría concreta de una vista. La 
herramienta Ocultar esconde los elementos seleccionados en la vista, y la herramienta 
Aislar muestra los elementos seleccionados y oculta los demás elementos de la vista. La 
herramienta sólo se aplica en la vista activa en el área de dibujo.  
 
Al cerrar el proyecto, la visibilidad de los elementos regresa a su estado original a menos 
convierta los cambios en permanentes. Aislar/Ocultar temporalmente tampoco afecta a la 
impresión.  
 

• Aislar categoría. Si selecciona algunos muros y puertas, sólo los muros y las 
puertas permanecerán visibles en la vista.  

• Ocultar categoría. Oculta todas las categorías seleccionadas en la vista. Si 
selecciona algunos muros y puertas, todos los muros y las puertas se ocultarán en 
la vista.  

• Aislar elemento. Aísla sólo los elementos seleccionados.  

• Ocultar elemento. Oculta sólo los elementos seleccionados. 
 
Para ocultar o aislar objetos temporalmente: 
 

1. En la barra de herramientas de control, hacer clic sobre el icono  (Temporary 
hide/isolate) 

2. En el listado escoger la opción requerida, tomando en cuenta las funciones de 
ocultar o aislar objetos por categoría o por elemento 

3. Para recuperar los elementos ocultos o aislados hacer clic sobre el icono  
(Temporary hide/isolate) 

 

 
 

4. Escoger la opción de restaurar el estado visible de los objetos 
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Reveal Hidden Elements (Revisar elementos ocultos) : La opción Mostrar elementos 

ocultos  esta desactivada por defecto, por lo tanto no muestra los elementos que se 

encuentren ocultos en la vista. Al activar el botón, este cambia de color a rojo  y en la 
vista se mostrarán en color rojo todos los elementos que están ocultos en la vista. 
 
Para activar objetos que están ocultos en la vista: 
 

1. Hacer clic sobre el icono  (Reveal Hidden elements) 
2. Seleccionar el elemento o elementos que se requieren visualizar. 
3. Hacer clic con el botón derecho del mouse. 
4. En el submenú escoger la opción Unhide in View  

 

 
 

Se despliegan las opciones disponibles para la visualización sea por elementos, 
categorías o filtros. 

También, en el panel Reveal Hidden Elements => escoger icono  (Unhide Element) 
 

5. Hacer clic sobre el botón  para desactivar el modo de visualización de objetos 
ocultos, o en el panel en panel Reveal Hidden Elements => escoger icono 

 (Toggle Reveal Hidden Elements Mode) 
 
Drawign Area / Área de dibujo (11) 
 
Las ventanas del área de dibujo de Revit se denominan vistas. Cada vez que se abre una 
vista en un proyecto, por defecto esta se despliega en el área de dibujo. Las vistas 
muestran la geometría del modelo tanto en 2D como 3D, además de los planos y los 
listados de cuantificación. 
 
Cada vez que se abre una vista se activa una pestaña (tab) que se muestra en la parte 
superior de la ventana de dibujo. Para pasar de una vista a otra, se debe hacer clic sobre 
la pestaña que corresponda al nombre de la vista que se quiere activar. 
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Se puede visualizar y organizar las vistas en la ventana de dibujo utilizando los comandos 
que se encuentran en: 
 

1. Menú View => panel Windows. 
 

 
 
Para visualizar varias vistas en el área de dibujo: 

1. Escoger pestaña View => panel Windows => icono  (Tile Views) 
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2. Para volver al modo de visualización de vistas por pestañas, presionar el icono 

 (Tab Views) 
 
Para cerrar las vistas que están inactivas: 
 

1. Activar la pestaña de la vista que se quiere mantener activa 

2. Escoger pestaña View => panel Windows => icono  (Close Inactive) 
 
 
Ribbons / Cinta de opciones (12) 
 
La cinta de opciones aparece al crear o abrir un archivo. Proporciona todas las 
herramientas necesarias para crear un proyecto o una familia. 
 

 
 
Los paneles (grupos) e iconos de la cinta de opciones tienen opciones: 
 
Grupos expandidos: Si aparece una flecha junto al título de un grupo, esto significa que 
es posible expandir el grupo para mostrar herramientas y controles relacionados. 
 
Ejemplo, Al expandir el grupo cotas, se observan las opciones de cotas existentes. 
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Apertura de cuadros de dialogo: Algunos grupos permiten abrir un cuadro de diálogo 

para definir parámetros relacionados. Una flecha como ésta   situada en la parte 
inferior de un grupo abre un cuadro de diálogo. 
 

 
 
Tabs on the Ribbon / Fichas de cinta de opciones (13) 
 
Son las pestañas que contienen los comandos o iconos. 
 

 
 
Contextual Tab / Pestaña contextual (14) 
 
Una ficha contextual de la cinta de opciones, que proporciona herramientas relevantes 
para el objeto seleccionado o la acción actual. Al utilizar ciertas herramientas o 
seleccionar elementos, se muestra una ficha contextual de la cinta de opciones que 
contiene una serie de herramientas relacionadas únicamente con el contexto de la 
herramienta o el elemento en cuestión. Esta ficha se cierra al salir de la herramienta o 
anular la selección. 
 

 
 
Tools on the current tab  / Herramientas de ficha actual (15) 
 
Herramientas en la ficha actual de la cinta de opciones 
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Panel on the Ribbon / Grupos de cinta de opciones (16) 
 
Grupos de la cinta de opciones 
 

 
 
 

Control de visibilidad de gráficos 
 
Controla la visibilidad y la presentación de gráficos de elementos de modelo, elementos 
de referencia y elementos específicos de vista para cada vista de un proyecto. 
 
Visibility Graphics (visibilidad de gráficos) 
 
La mayoría de las modificaciones de visualización de gráficos y visibilidad se realizan en 
el cuadro de diálogo Modificaciones de visibilidad/gráficos, excepto en el caso de las 
modificaciones en los elementos individuales, que se realizan en el cuadro de diálogo Ver 
gráficos de elementos específicos.  
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Para activar la caja de dialogo Visibility Graphics (VG): 
 

1. Escoger pestaña View => Panel Graphics =>  
2. Para desactivar la visualización de una o varias categorías de objetos en una vista, 

hacer clic sobre el cuadro a la izquierda del nombre de la categoría. 
 

 
 

3. Presionar el botón Aceptar para salir del cuadro de dialogo VG. 
 
 
Cambio de propiedades a categorías 
 
En el cuadro de diálogo visibilidad/gráficos, puede cambiar el color, grosor de línea, 
patrones de sombreado o transparencia a las categorías, ya sea por vista o por todo el 
proyecto. Si se ha modificado la visualización de gráficos de una categoría, las casillas 
bajo las columnas Lines/Patterns/Transparency muestra las propiedades asignadas, tanto 
en la sección Project Surface como Cut. 
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Project Surface: en esta sección se configura las propiedades de color, patrones de 
relleno o transparencia de objetos que en determinadas vistas se pueden observar su 
superficie. Por ejemplo; en una vista de planta se puede observar la superficie de un piso 
(floor), en una vista de elevación (Elev) se puede observar la superficie de un muro 
entonces, solo en este tipo de vistas aplicaran las propiedades asignadas a la categoría. 
 
Cut: en esta sección se configura las propiedades de color, patrones de relleno de objetos 
que en determinadas vistas se pueden observar en corte. Por ejemplo; en una vista de 
planta los muros (walls) se observan en corte, se pueden observar los pisos en corte en 
una vista de sección (section). 
 
En el cuadro de dialogo visibilidad de gráficos, se pueden observar varias pestañas. La 
pestaña. 
 

• Model Categories: permite activar o desactivar la visibilidad de elementos de las 
categorías  modelo de Revit 

• Annotation Categories: permite activar o desactivar la visibilidad de todos las 
categorías de los elementos de anotación. 

 

Cotas Temporales 
 
Las cotas temporales fuerzan el cursor al elemento perpendicular más cercano y se 
ajustan de acuerdo con el valor definido. 
 
Una vez colocado el elemento, Revit muestra las cotas temporales. Si se coloca otro 
elemento, las cotas temporales del elemento anterior desaparecen. Para ver las cotas 
temporales de un elemento, haga clic en Modificar y seleccione el elemento. Recuerde: 
las cotas temporales son las del elemento más cercano; por eso, las cotas que se ven 
pueden diferir de las temporales originales. Para mostrar las cotas siempre, cree cotas 
permanentes.  
Puede modificar cotas temporales para establecer referencia a los elementos que desee. 
Para ello, debe mover las líneas de referencia. También puede especificar la 
configuración de visualización y la colocación de las cotas temporales.  
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Las cotas temporales pueden convertirse en cotas permanentes de tal forma que se 
pueda establecer restricciones sobre los objetos con las cuales están relacionadas. 
 
Para configurar la justificación de las cotas temporales sobre muros: 

1. Escoger pestaña Manage=> panel Settings => desplegar icono  => 

opción  
2. En la caja de dialogo de propiedades de dimensiones temporales en la sección 

Walls escoger el tipo de justificación sobre los muros. 
3. En la sección Doors and Windows escoger la justificación sobre puertas y 

ventanas. 
 

 
 
Para convertir una cota temporal en permanente: 
 

1. Seleccionar un objeto 
2. Al activarse la cota temporal, hacer clic sobre el símbolo que se despliega bajo el 

valor de la cota temporal. 
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Para cambiar la línea de referencia de una cota temporal sobre un objeto: 
 

1. Seleccionar el objeto. 
2. Cuando se muestra la cota temporal, ubicar el cursor sobre el nodo de la línea de 

referencia que se quiere cambiar en la cota. 
 

 
 

3. Arrastrar el cursor sobre la nueva referencia en el objeto y hacer clic sobre el 
objeto, entonces la cota temporal cambiará los valores correspondientes. 
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Snaps 
 
Cuando se coloca un elemento, componente o se dibujan contornos, líneas, arcos etc., 
Revit despliega los puntos y líneas Snaps que ayudan a tomar un punto exacto sobre la 
geometría existente. Los puntos Snaps dependiente del tipo de Snap se representan con 
diferentes formas, por ejmplo; el punto Snap medio se representa con un triángulo, el 
punto Snap cuadrante con un rombo etc. 
 
 

 
 
Las líneas guías de los Snaps se representan punteadas de color azul. 
 

 
 
Los Snaps se configuran en la caja de dialogo Snaps y por defecto todas las opciones de 
puntos Snaps en Revit están activadas por defecto. Las opciones de Snaps tienen 
asignada una entrada por teclado, la cual se puede observar junto al nombre del punto 
Snap en el cuadro de dialogo Snaps. 
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Para abrir el cuadro de dialogo Snaps: 
 

1. Escoger pestaña Manage => panel Settings => icono  (Snaps). 
 

En forma predeterminada Revit tiene todas las opciones de Snaps activadas. 
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Incrementos de snpas 
 
A medida que se cambia el nivel de zoom en una vista, varían los incrementos de forzado 
de cursor. Al ampliar el zoom, los incrementos de forzado de cursor son más pequeños. Al 
reducir el zoom, los incrementos de forzado de cursor son más grandes. Se puede definir 
los incrementos para las longitudes y ángulos de cota según sus necesidades. 
 
Selección de objetos 
 
Revit cuenta con varias formas de selección, las cuales se describen a continuación. 
 
Para seleccionar objetos de forma individual en Revit: 
 

1. Hacer clic sobre el objeto hasta que se coloque de color azul. 
 

 
 

2. Para quitar la selección presionar la Tecla Esc del teclado. 
 
 
Para seleccionar varios objetos usando el puntero: 
 

1. Seleccionar el primer objeto. 
2. Presionar la Tecla Ctrl del Teclado y mantenerla presionada mientras se realiza la 

sección de los objetos adicionales haciendo clic sobre estos. 
 
Para eliminar objetos de un conjunto de objetos que están seleccionados: 
 

1. Debe haber varios objetos seleccionados. 
2. Presionar la Tecla Shift del Teclado y mantenerla presionada mientras se realiza 

la sección de los objetos que desea sacar de la selección. 
 
Para seleccionar objetos a través de una Ventana de selección: 
 

1. Hacer click cerca de los objetos a seleccionar. 
2. Mantener presionado el botón izquierdo del mouse 
3. Desplazar el cursor formando una Ventana de selección. 
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Filtros de selección 
 
Si en una selección hay elementos de diversas categorías, puede aplicar un filtro para 
eliminar de la selección las categorías que no desee. Por ejemplo, si en una selección hay 
muros, puertas, ventanas y mobiliario, puede utilizar un filtro para omitir el mobiliario.  
 
Para aplicar un filtro de selección: 
 

1. Seleccionar los objetos a través de una ventana de selección. 
 

 
 

2. Escoger la pestaña contextual Modify Multi-select => panel Selection => icono 

 (Filter) 
3. En el cuadro de dialogo Filter se despliega el listado de las categorías a la que 

pertenecen los elementos que están seleccionados en la vista. 
4. Dejar activa solo las categorías que se requiere mantener seleccionadas. Por 

ejemplo, la imagen muestra que las únicas categorías que se quieren dejar 
seleccionadas son puertas, ventanas y muros. 
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5. Presionar el botón Ok. Como resultado se observa que solo los objetos de las 
categorías que quedaron activas permanecen seleccionados. 
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Capítulo 2 
 

Tipos de objetos en Revit 
 
Existen tres tipos de elementos definidos en Revit:  
 

• Modelo 

• Referencia (Datum) 

• Específicos de vista 
 
Elementos de modelo 
 
Representan toda la geometría 3D real de un edificio. Aparecen en vistas relevantes del 
modelo. Ejemplos; Muros, ventanas, puertas, cubiertas, Muros estructurales, losas, 
rampas. Mobiliarios o equipos como; fregaderos, calderas, conductos, rociadores y 
paneles eléctricos. 
 
A su vez los elementos modelo se clasifican en dos tipos de elementos: 
  

• Anfitriones (host):  estos son los elementos construidos en el sitio de la 
construcción. Por ejemplo: Muros, techos, cubiertas, muros estructurales. 

 

• Componentes de modelo, éstos son todos los demás tipos de elementos en el 
modelo de construcción. Por ejemplo: ventanas, puertas, armarios, Vigas, 
tornapuntas y pilares estructurales etc.  

 
Elementos de referencia 
 
definen el contexto del proyecto. Estos elementos son; ejes, niveles y niveles de 
referencia. 
 
Elementos específicos de vista 
 
 Aparecen solo en las vistas en que se crearon. Son útiles para describir o documentar un 
modelo. Las cotas, tags, textos son ejemplos de específicos de vista. Los elementos 
específicos de vista se clasifican en: 
 
 

• Elementos de anotación: componentes 2D que documentan el modelo y 
mantiene la escala en papel. Por ejemplo; cotas, etiquetas y notas clave son 
ejemplos de elementos de anotación.  

 

• Detalles: elementos 2D que proporcionan detalles sobre el modelo de 
construcción en una vista particular. Líneas de detalle, regiones rellenadas y 
componentes de detalle 2D son ejemplos de detalles.  
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Diagrama elementos en Revit 
 

 
 
Todos los elementos en Revit están organizados por categorías, familias y tipos. 
 

Terminología de Revit 
 
Es importante comprender los conceptos relacionados al manejo de los objetos en Revit, 
la terminología que usa el software se describe a continuación. 
 
 
Categorías 
 
Las categorías están predeterminas en Revit, agrupan y ordenan las familias. Las 
categorías se pueden observar en el cuadro de dialogo VG. 
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Familias 
 
La clasificación de familias, por ejemplo, puertas, muros curtain, mobiliario, luminarias, 
etc, se crean o configuran, son las que representan la geometría y elementos de 
documentación que forman parte del proyecto. 
 
Tipos de familias 
 
Variaciones del elemento de familia. Por ejemplo, una familia podría ser una puerta con 
una ventana y los tipos podrían ser tres tamaños distintos para ese estilo de puerta. 
 
Familias de modelado 
 
Las familias cargables que representan objetos reales, como puertas, suelos o mobiliario. 
Estas familias se muestran en todas las vistas. 
 
Familias de anotación 
 
Las familias cargables que se utilizan para fines de anotación, como textos, cotas o 
etiquetas. Estas familias no tienen ninguna utilidad en términos de representación 3D y 
solo se muestran en las vistas donde están colocadas. 
 
Propiedades de instancia 
 
Contienen información relacionada con un ejemplar insertado específico del elemento de 
familia en un modelo. Por ejemplo, las propiedades de ejemplar de una puerta pueden 
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incluir la altura del alféizar y el material del marco. Los cambios realizados en las 
propiedades de ejemplar solo afectan a esa instancia de la familia. 
 
Propiedades de tipo 
 
Contienen información que se aplica a todos los ejemplares del mismo tipo de familia que 
hay en el modelo. Por ejemplo, las propiedades de tipo de una puerta pueden ser el 
grosor y la anchura. Los cambios realizados en las propiedades de tipo afectan a todas 
las instancias de la familia creada a partir del tipo correspondiente. 

 

Clasificación de las familias 
 
Todos los elementos utilizados en Revit son familias. Algunas familias, como las de muros 
o las de referencias de nivel, están incluidas en el entorno del modelo. Otras familias, 
como las de puertas o accesorios específicos deben cargarse en el modelo desde una 
biblioteca externa. No es posible crear nada en Revit sin utilizar una familia. 
 
Una familia es un grupo de elementos con un conjunto de propiedades comunes 
(llamadas parámetros) y una representación gráfica relacionada.  
Los distintos elementos que pertenecen a una familia pueden tener valores diferentes en 
algunos o todos sus parámetros, pero tienen el mismo conjunto de parámetros (sus 
nombres y significados). Estas variaciones dentro de la familia reciben el nombre de tipos 
de familia o tipos.  
 
Las familias se clasifican en: 
 
Familias de sistema 
 
Parte del entorno de Revit utilizado para crear elementos de construcción básicos, como 
muros, cubiertas y forjados. Las familias de sistema están predefinidas en Revit. No se 
cargan en los proyectos desde archivos externos, ni se guardan en ubicaciones externas 
al proyecto. 
 
Para cargar familias de sistema: 
 

1. Debe abrir o crear un archivo o plantilla de proyecto. 
2. En el navegador de proyectos ir hasta el apartado Families. 
3. Desplegar las categorías que corresponden a familias de sistema. 
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4. Se puede observar las familias y tipos cargados en la plantilla o proyecto. 
5. También Puede copiar y pegar familias de sistema de un proyecto o plantilla y 

aplicarlas a otro. 
 

Para crear tipos en las familias de sistema: 
 

1. En el navegador de proyectos desplegar la sección Familias. 
2. Buscar la familia de sistema y tipo que se quiere usar como base. 
3. Hacer clic derecho sobre el tipo que se quiere modificar o copiar para usarlo como 

referencia para crear un nuevo tipo. 
4. En el submenú escoger la opción Type Properties. 

 

 
 

5. Esto activa la caja de dialogo de propiedades de tipo, desde aquí podrá duplicar, 
cambiar el nombre y modificar parámetros como grosores, estructura, materiales 
etc. 

 



42 
 

 
 
 
Transferir familias de sistema de un proyecto o plantilla a otro archivo: 
 

1. Abrir el archivo desde el cual se requiere transferir las familias de sistema. 
2. Abrir el archivo al cual se requiere transferir las familias. 
3. Activar cualquier vista del archivo al cual se requiere transferir las familias de 

sistema. 

4. Escoger pestaña Manage =>panel Settings => icono  (Transfer project 
Standars) 

5. Activar las categorías a transferir 
6. Presionar el botón OK. 
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Familias cargables 
 
Estas familias tienen las siguientes características: 

  
• familias creadas independientemente del modelo y cargadas en el modelo según 

es necesario.  

• familias utilizadas para crear componentes de construcción instalados como 
puertas y accesorios, así como elementos de anotación.  

• familias que, a menudo, tienen como anfitrión familias de sistema. Por ejemplo, las 
puertas y ventanas tienen como anfitrión un muro.  

 
Al ser tan personalizables, las familias cargables son las que se crean y modifican con 
mayor frecuencia en Revit. A diferencia de las familias de sistema, las cargables se crean 
en archivos RFA externos y se importan a los proyectos o se cargan en ellos. Para las 
familias cargables que contienen muchos tipos, puede crear y utilizar catálogos de tipos a 
fin de cargar únicamente los tipos que se necesitan para un proyecto. 
 
Para cargar una familia a un proyecto: 
 

1. Abrir el archivo de proyecto 

2. Escoger la pestaña Insert => panel Load from Library => icono  (Load Family). 
3. Seleccionar la librería en la cual se requiere buscar. 
4. Buscar la carpeta según el nombre de la categoría del elemento a buscar. 
5. Seleccionar la familia o familias a cargar (archivos con extensión rfa). 
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6. Presionar el botón Open para cargar las familias al proyecto 
 
 
Familia in situ 
 
Elementos personalizados que el usuario crea en el contexto de un modelo. Cree una 
familia in situ cuando un modelo requiera geometría exclusiva, que probablemente no se 
vaya a reutilizar, o bien geometría que deba mantener relaciones con geometría de otro 
modelo. Como los elementos in situ se han concebido para un uso limitado en un modelo, 
cada familia in situ consta de un solo tipo. 
 

 
Formatos de archivo de Revit 
 
Puede crear archivos de diferentes formatos según el tipo de documentos que requiera 
generar: 
 
Plantillas de proyecto (RTE) 
 
Utilice plantillas de proyecto como punto de partida para los nuevos modelos. Utilice las 
plantillas por defecto o defina plantillas personalizadas para que se cumplan las normas 
de la empresa. Una plantilla de proyecto puede incluir plantillas de vista, familias 
cargadas, parámetros definidos (como unidades, patrones de relleno, estilos de línea, 
grosores de línea, escalas de vista, etc.) y geometría, si se desea.  
 
Las plantillas de proyecto usan la extensión de archivo RTE.  
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Archivos de proyecto (RVT) 
 
En Revit un proyecto es el diseño entero del edificio y la documentación asociada a este.  
Todas las vistas estándares del edificio, y las tablas de cuantificación se incluyen en el 
proyecto.  Siempre que se cambie el modelo, todas las visitas relacionadas, los dibujos, y 
las tablas se ponen al día automáticamente.   
 
Para iniciar un proyecto no se requiere un procedimiento rígido ni estandarizado, este 
puede iniciarse de diversas formas dependiendo las necesidades y complejidad, pero si 
se requiere tener una estrategia definida, antes de empezar a incluir cualquier 
componente en el proyecto, así que antes de iniciar un proyecto se deben tener en cuenta 
algunas de las siguientes sugerencias: 
 

• Configurar unidades de medida 

• Definir el número de niveles con los que cuenta el edificio 

• Iniciar el trazo preferentemente con los muros exteriores 

• Ligar el comportamiento de los muros con los niveles 
 
Cuando se comienza un nuevo proyecto se crea dos niveles de información por defecto, 
además se realizan automáticamente varias funciones.  Primero, se carga un archivo 
plantilla que contiene un subconjunto de componentes y de ajustes del sistema.  Esto 
pone los componentes a disposición para que el usuario comience a crear su diseño.  Los 
componentes individuales se van creando por el usuario más adelante, según los vaya 
necesitando.   
 
Para crear un proyecto: 

1. Escoger pestaña File => opción  =>  
2. En la caja de dialogo New Project desplegar la casilla Template file, para 

seleccionar el archivo de plantilla. 
3. En la sección Create new, escoger opción Project 
4. Presionar el botón OK. 

 
Información del proyecto: En la caja de dialogo información del proyecto, se incluye 
información básica relacionada con el proyecto como el nombre, número, cliente etc. 
 
Para agregar información del proyecto: 

1. Escoger pestaña Manage => Panel Settings => icono  (Project information) 
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Los archivos RVT son los denominados proyectos, los cuales guardan toda la 
información de los elementos modelados. 

 
Para grabar un archivo de proyecto: 
 

1. Escoger pestña File => Save As => Project 
2. Asignar el nombre al archivo, el cual por defecto tendrá extensión RVT. 

 
 
Archivos de familia (RFA) 
 
las cargables se crean en archivos RFA externos y se importan (se cargan) a los 
proyectos. 
 
Para cargar una familia al Proyecto: 

1. Escoger pestaña Insert => Panel Load from library => icono   (Load Family) 
2. Seleccionar una librería, y luego abrir la carpeta correspondiente a la categoría de 

familia. 
3. Seleccionar el archivo RFA que se requiere cargar al Proyecto. 
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Para eliminar familias que no se van a usar en el proyecto: 
 

1. Escoger pestaña Manage => Panel Settings => icono  
2. Para quitar la selección de los tipos, que por defecto estan seleccionados 

presionar el botón Check None. 
 

 
 

3. Desplegar las categorías y revisar familias y tipos que se quieren eliminar de la 
plantilla o proyecto, activando el recuadro que se encuentra al lado izquierdo de la 
familia o tipo. 
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4. Presionar el botón OK para purgar el archivo. 

 
Importante: para purgar familias o tipos de una familia de un archivo de plantilla o 
proyecto, estos no deben estar siendo usados. 
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Capítulo 3 
 

Manejo básico de vistas 
 
Vistas de Corte 
 
Las vistas de corte se generan automáticamente a partir de la colocación de los símbolos 
de sección (section). 
 
Las secciones o cortes se usan para ver la elevación del modelo a lo largo de un plano 
vertical específico. Las secciones pueden ser cortadas en segmentos, además pueden 
crearse secciones de referencia para vistas existentes. 
 
En Revit una sección se representa con una “línea de sección”, la cual tiene asociada una 
vista llamada “Vista de sección”. 
 
Una sección genera un corte de los componentes interiores visibles del modelo a lo largo 
de la línea de sección.  
 
Para crear una Vista de corte: 
 

1. Activar la vista de planta correspondiente 

2. Escoger Pestaña View => Panel Create => icono  (Section) 
3. Dibujar la línea de corte, especificando un punto inicial y un punto final. 

 

 
 

4. Para activar la vista de corte, hacer doble clic sobre la etiqueta de referencia de la 
línea de sección o en el Project browser desplegar la sección Sections (Building 
Sections). 
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Para hacer ajustes en una vista de corte: 
 

1. Se puede cambiar la dirección haciendo clic sobre la marca Flip Section. 
 

 
 

2. Puede cambiar profundidad y longitud que cubre la línea de corte, haciendo clic y 
arrastrando las guías de la línea de corte. 

 

 
 
Para cortar la línea de sección: 
 
La línea de sección puede cortar, para eliminar la visualización de cierta parte de la vista.  
 

1. Seleccionar la línea de sección, hacer clic sobre el símbolo  . 



51 
 

2. Una vez cortada la línea se puede seleccionar los nodos de los extremos para 
ajustar el área de corte 

 

 
 

3. Para eliminar el corte de la línea de sección hacer clic sobre el símbolo  
 
Para dividir una línea de sección: 
 
La línea de sección puede dividirse para generar una trayectoria irregular. 
 

1. Seleccionar la línea de sección 

2. En la pestaña contextual Modify Views => panel sections => escoger icono   
(Split Segment). 

3. Hacer clic sobre la línea de sección, en el sitio a dividir. 
 

 
4. Arrastrar el puntero en una dirección 
5. Hacer clic en el sitio donde colocará el segmento dividido 

 

 
Vistas 3D 
 
Se pueden crear vistas 3D desde las vistas de planta, elevación o sección. Existen dos 
tipos de vista 3D; Vista 3D paralelas y Vista de Cámara. 
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Cuando una vista 3D paralela o de cámara está activa, se muestran las opciones de 
navegación 3D, en la parte superior derecha de la vista.  
 
ViewCube: permite la visualización del diseño 3D desde diferentes puntos vista; frontales, 
laterales e isométricas. 
 

 
Puede hacer clic sobre los vértices o caras del cubo, para combinar ángulos de 
visualización en vistas isométricas. 
 

     
 
La herramienta Full Wheel Navigation, complementa las opciones para girar, realizar 
zoom, encuadre, y restituir las vistas anteriores a la actual (rewind) sobre las Vistas 
Default 3D.    
 

 
 
Vista 3D paralelas: Son las vistas 3D por defecto, la visualización de estas vistas se 
controla a través del View Cube, y muestran todos los elementos de la vista a la misma 
distancia y tamaño. 
 
 
Para crear una vista 3D: 

1. Escoger Pestaña View => Panel Create =>  
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2. Para usar las opciones del View Cube, hacer clic sobre cualquiera de las caras del 
cubo. 

 

 
 
3. En la rueda del View Cube, puede arrastrarse de forma interactiva para girar la vista 
 

 
 
4. Para hacer Zoom, Encuadre y Orbita en tiempo real, activar el comando Full 

Navigation Wheel, desde la barra de herramientas de navegación. 
  

 
 
 
Para cambiar el nombre de una vista 3D: 
 

1. Seleccionar la vista llamada 3D View, que está bajo la opción 3D View en el 
Project browser. 

 

 
 

2. Hacer clic con el botón derecho sobre el nombre de la vista {3D} 
3. En el submenú Escoger opción Rename… 
4. Escribir el nuevo nombre para la vista. 
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Capítulo 4 
 

Comandos de edición 
 
Las herramientas de modificación de Revit facilitan la manipulación de los objetos para 
efectos de modificar la posición, cambiar los tamaños, generar duplicados, cortar, unir, 
etc. 
 
La mayoría de los comandos de edición se pueden activar seleccionando el objeto y luego 
escoger pestaña Modify => Panel Modify. 
 
 
Align  
 
Mediante la herramienta Alinear, alinee uno o más elementos con un elemento 
seleccionado. Es una herramienta que suele usarse para alinear muros, vigas y líneas, 
pero también es válida para otros tipos de elementos.  
 
 
Para alinear objetos: 

1. Escoger pestaña Modify => Panel Modify => icono  (Align). 
2. Hacer clic sobre el elemento con el que quiere alinear 

 

 
 

3. Hacer clic sobre el elemento que requiere alinear 
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4. Como resultado los elementos se alienarán tomando como referencia los puntos 
indicados. 

 

 
 
Offset 
 
Use la función Desfase para crear, copiar o mover un elemento seleccionado, como un 
muro o una viga, a una distancia especificada y en dirección paralela al elemento 
seleccionado. 
 
Para desfasar un objeto: 

1. Escoger pestaña Modify => Panel Modify => icono  (Offset). 
2. En la barra de herramientas de opciones, en la casilla Offset, escribir la distancia a 

desplazar el objeto. 
 

 
 

Cuando la opción copy queda activa, se genera una copia del elemento a la 
distancia especifica indicada. 

 
3. Hacer clic sobre el objeto a desfasar, desplazando el curso hacia el lado hacia 

donde se requiere generar la copia. 
 

 
 

4. Como resultado se genera una copia del objeto seleccionado a la distancia 
especifica. 
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Mirror 
 
La herramienta Reflejar invierte la posición de un elemento de modelo seleccionado, 
utilizando para ello una línea como eje de simetría. Puede designar el eje de reflejo o 
dibujar un eje temporal. Use la herramienta Reflejar para voltear un elemento 
seleccionado, o para copiar un elemento e invertir su posición en un paso.  
 
Para reflejar un elemento: 
 

1. Seleccionar los objetos a reflejar 
 

 

2. Escoger pestaña Modify => Panel Modify => icono  (Mirror pick axis) o  
(Mirror draw) 

3. En caso de escoger el icono  (Mirror pick axis) , hacer clic sobre el elemento 
(eje de referencia) para generar el espejo. 

 

 
 

4. En caso de escoger la opción  (Mirror draw), debe dibujar el eje de ferencia 
para generar el espejo, definiendo un punto inicial y un punto final. 
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5. Como resultado se generan copias en espejo de los objetos seleccionados. 
 

 
      
Split 
 
Corta un elemento (los elementos arquitectónicos que se pueden cortar son: muros, 
barandales, columnas o líneas) en un punto seleccionado. 
 
Para cortar un elemento: 
 

1. Escoger pestaña Modify => Panel Modify => icono   (Split elements) 
2. Hacer clic en el punto donde se requiere cortar el elemento 

 
 

3. El objeto se divide en dos 
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Para dividir un elemento con separación: 
 

1. Escoger pestaña Modify => Panel Modify => icono   (Split elements) 
2. Hacer clic en el punto donde se requiere cortar el elemento 

 
 

3. En la barra de opciones escribir el valor de separación en la casilla Joint Gap 
4. Como resultado el objeto se divide tomando como referencia el valor de 

separación indicado. 
 

 
 
Move 
 
La herramienta Mover funciona de forma parecida a la acción de arrastrar. Sin embargo, 
presenta funciones adicionales en la barra de opciones y permite una colocación más 
precisa. 
 
Para mover un objeto: 
 

1. Seleccionar el objeto 

2. Escoger pestaña Modify => Panel Modify => icono   (Move) 
3. Hacer click en el punto base elegido para el desplazamiento 

  

 
 

4. Mueva el cursor en el sentido hacia el que desee desplazar el elemento. 
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5. Hacer click sobre la vista en el sitio donde se requiere colocar el objeto o introducir 
el valor exacto de la distancia a desplazar en la cota temporal y presionar enter. 

 
6. Los objetos en Revit pueden moverse de una ubicación a otra solo seleccionando 

el objeto y arrastrándolo. 
 

 
Copy 
 
La herramienta Copiar permite copiar uno o varios elementos seleccionados, y se usa 
para colocar las copias en el dibujo de manera inmediata y a una distancia específica.  
 
Para copiar objetos: 

1. Escoger pestaña Modify => Panel Modify => icono   (Copy) 
2. Hacer click en el punto base elegido para desplazamiento  
3. Para realizar varias copias del elemento seleccionado, en la barra de herramientas 

de opciones activa la opción Multiple. 
 

 
 
La opción Constrain, restringe el movimiento del cursor en modo ortogonal. 
 

4. Mueva el cursor en el sentido hacia el que desee copiar el elemento 
5. Hacer click sobre la vista en el sitio donde se requiere colocar el nuevo objeto o 

introducir el valor exacto de la distancia en la cota temporal y presionar enter. 
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Trim / Extend 
 
Utilice las herramientas Recortar y Extender para recortar o extender uno o varios 
elementos en un contorno. También puede extender elementos no paralelos desde una 
esquina, o recortarlos desde una esquina si intersecan. Cuando selecciona un elemento 
para recortarlo, la posición del cursor indica la parte del elemento que desea conservar. 
Puede utilizar estas herramientas con elementos como muros, líneas, través, vigas. 
 
Revit cuenta con tres opciones para recortar / extender elementos: 
 

• Trim/Extend to Corner : Se usa cuando un elemento debe recortarse para 
conformar una esquina.  

• Trim/Extend Single element : Se usa para recortar o extender un elemento 
hasta un contorno definido por otro elemento. 

 

• Trim/Extend Multiple Elements : Se usa para recortar o extender elementos 
hasta un contorno definido por otro elemento. 

 
Para extender elementos: 

1. Escoger pestaña Modify => Panel Modify => icono    o o  (Trim/Extend) 
2. Seleccionar el objeto que servirá de límite o contorno. Debe seleccionar el objeto 

del lado que desea conservar. 
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3. Seleccionar el objeto a extender. 

 
 

4. Según la herramienta seleccionada el resultado se observa en las siguientes 
imágenes. 

 

 
  

Para recortar elementos: 
 

1. Escoger pestaña Modify => Panel Modify => icono    o o  (Trim/Extend) 
2. Seleccionar el objeto que servirá de límite o contorno.  

 

 
3. Seleccione el objeto a recortar. Debe seleccionarlo del lado que desea conservar. 
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4. Según la herramienta seleccionada el resultado se observa en las siguientes 
imágenes. 

 

 
 
Array 
 
Genera un arreglo radial o lineal de elementos seleccionados, creando varios ejemplares 
a partir de uno o más elementos que se agrupan y pueden ser modificados 
simultáneamente.  Los elementos de la matriz pueden pertenecer a un grupo. Por lo tanto, 
puede agregar o quitar elementos del grupo. Hay dos tipos de matrices lineales y radiales. 
 
Matrices lineales: Crea arreglos que disponen los nuevos objetos formando filas y 
columnas a una distancia especifica. 
 
Para crear una matriz lineal: 
 

1. Seleccionar los objetos a copiar 

2. Escoger pestaña Modify => panel Modify => icono  (Array). 

3. En la barra de herramientas de opciones escoger opción Linear  
4. En la casilla Number escribir el número de copias a generar 

 

 
 
La opción “Move To:”, activa por defecto indica que el número de copias incluye en la 
cuantificación el objeto original. 
 

5. Sobre el objeto(s) a copiar, hacer clic sobre el punto base de copia. 
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6. Desplazar el cursor hacia el lado donde se quieren generar las copias, en la cota 
temporal, escribir la distancia a la cual se generan copias. 

 

 
 

7. Presionar Enter para generar el arreglo lineal 
 

 
 

8. Se puede cambiar la cantidad de copias del arreglo, haciendo clic sobre cualquiera 
de los elementos y modificando el valor de la cota temporal. 

 

 
 
Matrices radiales: Dibujando un círculo o arco puede especificar el número de elementos 
que desea mostrar en la matriz.  
 
Para crear una matriz radial: 
 

1. Seleccionar el objeto(s) 
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2. Escoger pestaña Modify => panel Modify => icono  (Array). 

3. En la barra de herramientas de opciones escoger opción radial   
4. En la casilla Number escribir el número de copias a generar 

 

 
 
La opción “Move To:”, activa por defecto indica que el número de copias incluye en la 
cuantificación el objeto original. 
 

5. En la casilla ángulo debe indicarse el valor del ángulo a cubrir por la circunferencia 
6. En la vista seleccionar el punto que será el centro de la circunferencia. 

 

 
 

7. Definir el ángulo de origen del objeto. 
 

 
 

8. Definir el ángulo final de rotación del objeto. 

 
 

9. Presionar Enter. 
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9. Puede cambiar la cantidad de copias del arreglo, haciendo clic sobre cualquiera de 
los elementos y modificando el valor de la cota temporal. 

 

 
  

10. Al arrastrar uno de los nodos de la circunferencia, puede cambiar el ángulo que 
cubre la circunferencia del arreglo. 

 

 
 
Rotate (Rotar) 
 
Rotar permite que los elementos roten en torno a un eje.  En las vistas de plano de planta, 
de techo, alzado y sección, los elementos rotan en torno a un eje perpendicular a la vista. 
En las vistas 3D, el eje es perpendicular al plano de trabajo de la vista.  
 



66 
 

Para rotar un objeto: 
 

1. Seleccionar el objeto 

2. Escoger pestaña Modify => panel Modify => icono   (Rotate) 
3. Se despliega el eje de rotación, representado con un punto azul. Puede mover el 

eje de rotación arrastrándolo a una nueva ubicación.  
 

 
4. Especificar el ángulo inicial de rotación, desplazando el puntero en el ángulo 

requerido y hacer clic sobre el punto inicial de rotación. 
 

 
 

5. Definir el ángulo final de rotación, desplazando el puntero en el ángulo requerido o 
ingresando el valor del ángulo en la cota temporal. 

 

 
 
Scale 
 
Cambia el tamaño de los elementos modelo. Revit calcula un factor de escala utilizando 
dos opciones, gráfica o numérica. 
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• La escala gráfica: cambia la escala de elementos gráficamente, definiendo tres 
puntos: el primer punto determina el origen; los otros dos definen los vectores de 
escala. 

• La escala numérica: se cambia indicando un factor de escala y especificando el 
origen. 

 
Para cambiar la escala gráfica: 
 

1. Seleccionar un objeto 

2. Escoger pestaña Modify => panel Modify => icono   (Scale) 

3. En la barra de herramientas de opciones escoger la opción  
4. Definir primer punto (punto de origen) 

 

 
5. Definir el segundo punto (punto de arrastre) 

 

 
 

6. Definir tercer punto (determina el nuevo tamaño) 
 



68 
 

 
Para cambiar escala numérica: 
 

1. Seleccionar un objeto 

2. Escoger pestaña Modify => panel Modify => icono   (Scale) 
3. En la barra de herramientas de opciones escoger la opción  Numerical 

 

 
 

4. En la casilla Scale ingresar el valor de escala. 
 

 
 

5. Definir el punto de origen, observar el cambio de tamaño del objeto. 
 

 
En el ejmplo se muestra que el valor de escala se ingreso en 0.5, lo cual indica 
que el objeto debe reducir su tamaño a la mitad. 
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Pin / Unpin 
 
Bloquea o desbloquea la ubicación de un objeto. 
 

1. Seleccionar el objeto 

2. Escoger pestaña Modify => panel Modify => icono   (pin) 
3. Un objeto bloqueado muestra un icono en forma de pin 

 
 

4. Para quitar el bloqueo, puede hacer clic sobre le icono pin que se observa sobre el 

objeto cuando este se selecciona o hacer clic sobre el icono  (Unpin) 

 
 
Delete (Borrar objetos) 
 
Elimina los objetos seleccionados del proyecto. 
 

1. Seleccionar los objetos a borrar 

2. Escoger pestaña Modify => panel Modify => icono   (Delete) o presionar la tecla 
suprimir el teclado. 

 
Copy to Clipboard 
 
La herramienta Copiar a portapapeles copia uno o más elementos en el portapapeles. A 
continuación, para pegar copias de los elementos en el dibujo activo o en otro proyecto 
debe utilizar las herramientas Pegar desde portapapeles o Pegar alineado. 
 
Para copiar y pegar elementos del portapapeles: 
 

1. Seleccionar los objetos a copiar. 

2. Escoger pestaña Modify => panel Modify => icono   (Copy to Clipboard) 

3. Escoger pestaña Modify => panel Modify => icono   (Paste) 
Se despliegas las opciones disponibles para pegar objetos que están en el 
portapapeles. 
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Por ejemplo un uso comun de esta herramienta es copiar objetos a otros niveles del 
proyecto, entonces: 
 

4. Esccoger la opción  
5. Se puede seleccionar uno o más niveles en el listado de la caja de dialogo select 

Levels 
 

 
 

6. Presionar el botón OK. 
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Capítulo 5 
 

Plantillas de proyecto (Template) 
 
Las plantillas de proyecto son un punto de partida para los nuevos modelos. Utilice las 
plantillas por defecto o defina plantillas personalizadas para que se cumplan las normas 
de la empresa.  
 
Una plantilla de proyecto puede incluir plantillas de vista, familias cargables, parámetros 
definidos (como unidades, patrones de relleno, estilos de línea, grosores de línea, escalas 
de vista, etc.) y geometría. 
  
Las plantillas de proyecto usan la extensión de archivo RTE. Al instalar Revit proporciona 
varias plantillas para diferentes disciplinas y tipos de proyectos de construcción. Las 
plantillas se guardan en la siguiente ubicación:  
 
%ALLUSERSPROFILE%\Autodesk\RVT 2019\Templates  
 
Crear plantilla de proyecto 
 
También puede crear plantillas personalizadas para satisfacer necesidades específicas o 
garantizar el cumplimiento de las normas de la empresa.  
 
Para crear una plantilla de proyecto: 
 

1. Escoger pestaña File => opción  =>  
2. En la caja de dialogo New Project desplegar la casilla Template file. 
3. Escoger la plantilla de proyecto a usar. 

 

 
 

También puede presionar el botón Browse para escoger la plantilla base que 
usará. 
 

4. En la sección Create New escoger Project Template 
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5. Presionar el botón Ok para crear el archivo de plantilla. 
 
Para grabar un archivo de plantilla: 
 

1. Escoger pestña File => Save As => Template 
2. Asignar el nombre al archivo, el cual por defecto tendrá extensión RTE. 

 
Configurar listado de plantillas  
 
Es posible especificar los archivos de plantilla que se usan con más frecuencia en una 
lista que se mostrará en la ventana New Project, bajo la sección Template file. 
 

 
 
Para configurar plantillas en el listado de plantillas: 
 

1. Desplegar el Menú File => escoger Options 
2. En el lado izquierdo de la caja de dialogo de opciones, seleccionar la opción File 

Locations. 

3. Bajo la sección Project Template Files: hacer clic sobre el botón  (Add Value). 
4. Buscar y seleccionar la plantilla que se requiere agregar a los listados. 

 

 
 
Familias de sistema en plantillas 
 
Puede modificar o duplicar familias de sistema para ajustarlas a los requerimientos más 
comunes de los proyectos. 
 
Para visualizar las familias de sistema cargadas en una plantilla de proyecto: 
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1. En el navegador de proyectos, ir hasta la sección Families. 
2. Desplegar la categoría correspondiente a una familia de sistema. 
3. Seleccionar la familia de sistema que se requiere modificar. 
4. Desplegar la familia hasta observar los diferentes tipos cargados en la plantilla. 

 

 
 
Para modificar el tipo de una familia de sistema: 
 

1. Ubicar en tipo a modificar. 
2. Hacer clic con el botón derecho del mouse, en el submenú escoger Type 

Propesties… 
 

 
 

3. Se muestra la caja de dialogo Propiedades de tipo, la cual permite realizar los 
cambios permitidos sobre el tipo seleccionado. 

 
Familias cargables en plantillas 
 
Puede cargar familias, por ejemplo, familias personalizadas (RFA) o de uso habitual en 
los proyectos (puertas, ventanas, mobiliario etc), y cuadros de rotulación. 
 
Para cargar una familia RFA: 
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1. Escoger pestaña Insert => Load from Library => icono  
2. En la carpeta Libraries seleccionar la carpeta de librerías a usar  
3. Las subcarpetas están nombradas de acuerdo con las categorías existentes en 

Revit 
 

 
 

4. Seleccionar el archivo RFA a cargar a la plantilla. 
5. Presionar el botón Open. 

 
Las familias RFA cargadas en la plantilla de proyecto también se pueden visualizar en el 
navegador de proyectos. 
 
Recomendaciones sobre plantillas de proyectos 
 
Las plantillas de proyecto proporcionan un entorno inicial y normas para los modelos 
nuevos. A continuación, se indican algunas recomendaciones y pautas al crear plantillas 
de proyecto personalizadas: 
 
Ubicación del contenido: Una plantilla de proyecto puede contener familias 
personalizadas, como; cuadros de rotulación, elementos de modelo, como puertas y 
ventanas, y elementos de anotación, como, etiquetas de elementos y referencias a vistas. 
Antes de crear una plantilla de proyecto, designe una ubicación para almacenar las 
familias personalizadas; de esta forma podrá acceder a ellas fácilmente. Se recomienda 
conservar el contenido personalizado por separado del contenido proporcionado por 
Autodesk. 
 
Estándares de nomenclatura: Utilizar estándares de nomenclatura claros le ayudará a 
tener la plantilla organizada y contribuirá a hacerla fácil de utilizar. Cuando avance por los 
elementos de esta lista de comprobación, piense sobre los estándares de nomenclatura 
que utilizará para todos los elementos (familias, vistas, materiales, etc.).  
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Anotaciones: Una plantilla de proyecto debe incluir las familias de anotación que vaya a 
utilizar en el modelo. Debido a que las anotaciones se cargan en la plantilla, no será 
necesario cargarlas la primera vez que se utilicen en el modelo. Este método permite 
ahorrar tiempo y reducir los errores causados por cargar una familia incorrecta.  
 
Cuadros de rotulación: Cree familias de cuadros de rotulación para todos los diferentes 
planos que necesite para documentar sus proyectos. Cargue las familias de cuadros de 
rotulación en la plantilla para ahorrar tiempo y reducir el número de errores durante el 
desarrollo del proyecto.  
 
Contenido: Cree el contenido básico de familias de sistema en la plantilla. Cree suficiente 
contenido para cubrir los usos habituales de un modelo. Incluya información como, por 
ejemplo, notas clave y marcas de tipo en los parámetros de los elementos.  
 
Entre las familias del sistema que se deben tener en cuenta, se incluyen: Muros, pisos, 
techos, cubiertas, muros curtain, paneles muro curtain, Montantes/perfiles. 
  
También debería incluir familias cargables en la plantilla. Puesto que el contenido 
cargable (como puertas, ventanas, pilares y vigas) se coloca en la plantilla, tenga en 
cuenta la forma en que estos elementos aparecerán en una tabla de planificación. Incluya 
todos los parámetros compartidos o de proyecto necesarios para el contenido cargado en 
la plantilla.  
 
Vistas, tablas de cuantificación y planos: Cree vistas típicas en la plantilla de proyecto 
para que no se tengan que crear al principio de cada proyecto. Las siguientes son algunas 
vistas de ejemplo que puede crear:  
 

• Plano de la primera planta  

• Plano de techo reflejado  

• Alzados exteriores 
  
Puede añadir tablas de cuantificación vacías a la plantilla del proyecto. Puede dar formato 
a las tablas de cuantificación una sola vez en la plantilla, con lo que no tendrá que hacerlo 
para cada proyecto.  
 
Clasificación por tipos de vista o por navegador: Valore la opción de añadir 
parámetros de proyecto o compartidos a la categoría Vistas de la plantilla. Estos 
parámetros se pueden utilizar en el proyecto para ayudar a organizar el Navegador de 
proyectos conforme avanza el proyecto. Para determinar los parámetros que debe añadir, 
piense primero en cómo suele organizar y clasificar los dibujos y los planos. Por ejemplo, 
puede que le convenga clasificar los planos en categorías como planos de planta, planos 
de disposición de mobiliario, planos ampliados, planos de acabados, etc.  
 
Materiales y patrones de sombreado: Cree una biblioteca de materiales habituales en la 
plantilla del proyecto. Cuando cree materiales, no tenga en cuenta solo su aspecto, sino 
también cómo les añadirá las notas clave o cómo los utilizará para el cómputo de 
materiales.  
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Los patrones de relleno para superficies de materiales y patrones de corte también se 
definen en la plantilla y se deberían generar de forma específica para cada material. Esto 
le ayudará a reducir errores al seleccionar patrones de relleno para nuevos materiales.  
 
Estilos de línea: Los estilos de línea definidos en la plantilla se deberían generar de 
forma específica para su uso en el proyecto. Los tipos de línea creados específicamente 
reducirán los posibles errores al seleccionar un tipo de línea para su uso.  
 
Estilos de objetos/grosores de línea: Defina los estilos de objeto y los grosores de línea 
en la plantilla de proyecto para que los gráficos resultantes cumplan los requisitos.  
 
 

Unidades de medida 
 
Las unidades de proyecto se agrupan por disciplinas: común, estructura y Mep. Cuando 
se cambia de disciplina, hay disponibles tipos de unidades diferentes. En el cuadro de 
diálogo Unidades de proyecto, cada tipo de unidad tiene una vista previa del formato de 
visualización. Para proyectos arquitectónicos la disciplina Común es la que se usa como 
base. 
 
 
Para configurar unidades de medida: 

1. Escoger pestaña Manage => Panel Settings =>  
2. La caja de dialogo de unidades de medida, muestra el formato actual de unidad de 

medida que se está usando. 
 

 
 

3. Bajo la columna Units, se encuentran las unidades de medida que se pueden 
configurar en Revit. 

4. Bajo la columna Format, puede hacer clic en cada botón que esta frente a la 
opción de unidad y configurar el formato de la unidad de medida.  

 
En la caja de dialogo Format se configuran unidades, cantidad de decimales, 
simbología y el formato para separación de dígitos. Esto mismo se aplica para 
cada una de las diferentes unidades de medida. 
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5. Presionar el botón OK para salir del cuadro de dialogo de unidades de medida. 
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Capítulo 6 
 

Iniciar un proyecto 
 
Un proyecto provee de información esencial acerca del modelo del edificio, tal como 
tamaño, localización de componentes, materiales usados, anotaciones etc.  
 
Puede utilizar como referencia un plano en formato CAD para comenzar un modelo en 
Revit, o empezar a modelar el proyecto desde cero. 
 
Importación de archivos CAD 
 
Puede importar o vincular datos de otros programas de CAD a un modelo de Revit y 
además es posible controlar diversos aspectos del proceso, como por ejemplo colores, 
capas y posición. 
 
Las opciones que se deben considerar para importar un archivo CAD se muestran en la 
caja de dialogo Import CAD, y se indican a continuación: 
 
Current view only: Cuado está activo, importa un dibujo de CAD solo en la vista activa y 
los elementos se comportan como anotaciones. Si la opción no está seleccionada, la 
importación se comporta como geometría de modelo y está disponible en todas las vistas.  
 
Colors: Tiene tres opciones: 
 

• Invert: Invierte los colores de todos los objetos de texto y de línea del archivo 
importado a colores específicos de Revit. Los colores oscuros se vuelven más 
claros y los colores claros se vuelven más oscuros. Esto puede mejorar la 
legibilidad cuando el archivo se encuentre en Revit.  

 

• Preserve: Mantiene los colores definidos en el archivo importado. Los colores 
RGB se importan como colores de índice y se convierten a color RGB. Es posible 
que los colores RGB no coincidan completamente con el archivo original.  

 

• Black and White: Importa el archivo en blanco y negro. 
 
Layers/Levels: Tiene tres opciones: 
 

• All: Importa o vincula todas las capas. Las capas que no estén visibles en el 
vínculo se desactivarán en la vista actual de Revit. 

 

• Visible: Importa o vincula todas las capas visibles. 
 

• Specify: Permite seleccionar las capas y niveles que se van a importar o vincular 
(en el cuadro de diálogo que se muestra). Las capas que no se seleccionen se 
suprimirán.  
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Si más adelante desea vincular las capas omitidas, deberá suprimir el vínculo y 
volver a vincular el archivo.  

 
Import units: Establece de forma explícita la unidad de medida de la geometría 
importada. Los valores son Autodetectar, pies, pulgadas, metro, decímetro, centímetro, 
milímetro y Factor personalizado.  
 
Al escoger Autodetectar para un archivo de AutoCAD creado con unidades imperiales 
(sistema inglés), el archivo se importa tomando como unidades los pies y las pulgadas. Si 
el archivo de AutoCAD se crea con unidades métricas, se importa a Revit tomando como 
unidades los milímetros.  
 
Si se importa un archivo en un proyecto con unidades opuestas, por ejemplo, un archivo 
con sistema métrico en un proyecto con sistema imperial, prevalecen las unidades del 
proyecto principal.  
 
Si el archivo importado tiene una unidad personalizada, seleccione “Custom factor” en 
Unidades de importación. De esta forma, se habilitará el cuadro de texto adyacente a la 
lista de selección para que pueda introducir un valor de escala.  
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Supongamos que el archivo tiene una unidad llamada "widget", que equivale a 10 metros. 
Al importar el archivo, seleccione Custom factor: en Unidades de importación y 
especifique un valor de 10 en el cuadro de texto adyacente. Cada unidad del archivo de 
origen equivale ahora a 10 metros en el archivo de Revit.  
El valor que indique aquí se mostrará en la propiedad de tipo Factor de escala del símbolo 
de importación.  
Si se trata de unidades conocidas, puede elegir Factor personalizado e indicar un factor 
de escala. Esto puede aumentar o reducir el tamaño de los elementos importados a Revit.  
 
Correct lines that are slightly of axis: Esta opción, activada por defecto, corrige 
automáticamente las líneas que están ligeramente fuera del eje (menos de 0,1 grados) y 
ayuda a evitar problemas relacionados con los elementos de Revit generados a partir de 
dichas líneas. Es posible que desee desactivar esta opción cuando realice una 
importación o vinculación de topografías. 
 
Posición: Permite especificar el modo en que la geometría importada se coloca respecto 
al modelo anfitrión. Las opciones de posicionamiento de tipo automático pueden usarse 
si se conoce la posición de las coordenadas del modelo anfitrión y las del archivo 
importado o vinculado. Las opciones de posicionamiento de tipo manual permiten colocar 
la geometría importada según un punto específico definido en el archivo importado o 
vinculado. Estas opciones ofrecen control directo de la posición de la geometría entrante 
en el modelo anfitrión.  
 
Las opciones de posicionamiento son: 
 

• Auto Center to Center: coloca el centro de la geometría importada en el centro 
del modelo anfitrión de Revit. Tanto en la geometría importada como en el modelo 
anfitrión, el centro geométrico se calcula hallando el centro de un cuadro de 
delimitación alrededor de la geometría.  

 
En la imagen se observa la coincidencia del centro de la geometría importada y la 
geometría del anfitrión:  
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No utilice Automático - Centro a centro si debe repetir la importación de un archivo 
o importar varios archivos en el modelo anfitrión. Esta opción determina el centro 
en función de la geometría en el momento de importar o vincular el archivo. 

 

• Auto Origin to Origin: Seleccione esta opción para colocar el origen de la 
geometría importada en el origen del modelo anfitrión de Revit. En un modelo de 
Revit, el origen se denomina también origen interno. Al crear un proyecto de Revit, 
el punto base del proyecto corresponde al origen interno.   

 
Importante: El punto base del proyecto se puede desplazar de modo que deje de 
corresponder al origen interno. 
 
En la imagen: 
 

 
 

 
 
 
 
 
 

http://help.autodesk.com/view/RVT/2019/ESP/?guid=GUID-68611F67-ED48-4659-9C3B-59C5024CE5F2
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Use Automático - Origen a origen si debe utilizar un punto común para coordinar la 
posición de varios vínculos o importaciones. Los puntos de origen del modelo 
anfitrión y la geometría entrante se mantienen constantes, sea cual sea la 
geometría en cada archivo. 

 

• Manual Origin: Seleccione esta opción para mostrar la geometría importada en la 
vista actual, con el cursor colocado en el origen universal de la importación o el 
vínculo. 

 

• Manual Center: Seleccione esta opción para mostrar la geometría importada en la 
vista actual, con el cursor colocado en el centro geométrico de la importación o el 
vínculo. 

 
 
Para importar archivos DWG: 
 

1. Abrir el proyecto en la cual se requiere importar el archivo CAD 
2. Activar la vista en la cual se importará el archivo CAD 

 

3. Escoger pestaña Insert => panel Import =>  
4. Buscar y seleccionar el archivo a importar 
5. En la caja de dialogo Import CAD Formats, escoger las opciones según las reglas 

de importación a aplicar. 
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6. Escoger la opción Open para importar la geometría. 
 
Manejo de archivos importados 
 
Al importar un dibujo a Revit, se importan con él todos sus elementos, entre ellos bloques 
y referencias externas (xrefs) del dibujo. Esos elementos se encuentran dentro de un 
elemento denominado símbolo de importación. 
 
Al seleccionar el símbolo importado (Archivo CAD), se puede consultar información 
acerca de los elementos para ver sus propiedades. 
 
Para ver las propiedades de los elementos de un símbolo importado: 
 

1. Seleccionar símbolo importado. 

2. En la pestaña Contextual Modify => panel Import Instance => escoger icono   
(Query). 

3. Hacer clic sobre el elemento a consultar. 
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4. Se muestran las propiedades el elemento CAD 
 

 
 
 
Para borrar capas de un símbolo importado: 
 

1. Seleccionar símbolo importado 

2. En la pestaña Contextual Modify => panel Import Instance => escoger icono   
(Query) 

3. Seleccionar las capas a borrar en el listado que aparece en el cuadro de dialogo 
Select Layers/Levels to Delete 
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4. Presionar el botón Ok para salir del cuadro de dialogo. 
 
 
Descomponer geometría importada: Es posible descomponer el símbolo de 
importación, puede escoger entre dos opciones: 
 

• Full Explode: permite obtener directamente texto, curvas, líneas, bloques y 
regiones rellenadas de Revit.  

 

• Partial Explode: Una descomposición parcial de un símbolo de importación 
produce otros símbolos de importación que, a su vez, pueden descomponerse 
para producir elementos u otros símbolos de importación. Se trata de una 
operación similar a la descomposición en AutoCAD con bloques y referencias 
externas. No es posible descomponer archivos vinculados ni símbolos de 
importación compuestos por más de 10.000 elementos. 

 
Para descomponer geometría importada: 
 

1. Seleccionar símbolo importado 
2. En la pestaña Contextual Modify => panel Import Instance => desdeplar icono 

  (Explode) 
3. Escoger Full Explode o Partial explode. 
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Creación de niveles y ejes 
 
Niveles  
 
Los niveles son planos horizontales infinitos que determinan la altura vertical del edificio.  
Los objetos se ligan a estos planos.  Por lo tanto, los cambios realizados a la localización 
de un plano propagan automáticamente a los objetos ligados.  Por ejemplo, un muro 
podría empezar en el primer nivel y terminar en el nivel de la azotea.  Si cualquiera de los 
dos niveles cambia, el muro se actualizará automáticamente en todas las vistas del 
proyecto. 
 
Para añadir niveles, es preciso estar en una vista de alzado o en sección. Cuando se 
añaden niveles, se crea una vista de plano asociada. 
 

 
 
Para crear niveles: 
 

1. Se activa cualquier vista de Elevación (Este, Norte, Sur, Oeste) 

2. Activar pestaña Architecture => Panel Datum =>  (Level) 

3. En la pestaña Contextual  en el panel Draw, escoger la opción 
requerida para dibujar el nivel, Line o Pick Line. 

 
Crear un nivel usando opción Line: 
 

1. Al escoger la opción  (Line): deberá dibujar el nivel como una línea definiendo 
un punto inicial y punto final. 
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2. Ajustar la altura del nivel, seleccionándolo y editando la cota de altura de nivel 

 

 
 
 
Para crear un nivel usando opción Pick line: 
 

1. Al escoger la opción  (Pick Line): primero se debe definir la altura a la cual 
colocará el nivel con respecto al elemento que usará como referencia, este valor 

debe ingresarse en la casilla Offset en la barra de opciones    
 

2. Hacer clic sobre la línea que se usará como referencia para crear el nivel. 
 

 
 

 
3. Observar que la línea del nuevo nivel se proyecte en la dirección correcta (líneas 

punteadas de color azul) 
 
Por cada nivel definido, se crea automáticamente una vista de planta y una vista de techo, 
las cuales se pueden activar desde el Project Browser. 
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Copiar niveles: Otra forma de crear niveles es generar copias de los niveles existentes a 
una distancia especifica utilizando el comando Copy. 
 
Para copiar niveles: 
 

1. Seleccionar la línea de nivel a copiar. 
 

 

2. Escoger pestaña contextual Modify Level => panel Modify => Icono  (copy) 
3. Hacer clic sobre la línea de nivel 

 

 
4. Desplazar el cursor hacia arriba o abajo, e ingresar la altura del nuevo nivel en la 

cota temporal. 
 

 
 
Cambiar la simbología de líneas de nivel: puedes cambiar los símbolos que usan las 
líneas de nivel personalizando o cargando las familias de simbología de niveles que 
incluye Revit en sus librerías. 
 
Para cargar familias de símbolo de nivel: 
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1. Escoger pestaña Insert => panel Load From to Library => icono  (Load 
Family) 

2. Abrir la carpeta de librerías, buscar entre las familias de simbolos de nivel la que 
se requiere usar (Los nombres de los archivos de familia que contienen simbología 
para niveles comienzan con M_Level*, esto aplica en caso que se esté usando la 
librería US METRIC). 

 

 
 

3. Seleccionar la familia y cargarla. 
 
Personalizar el nombre de tipo de la familia de simbología de niveles: 
  

4. En una vista de alzado seleccionar una o varias líneas de nivel 

5. Entrar a las propiedades de tipo  
6. Seleccionar un tipo en la casilla Type 

 

 
 

7. Presionar el botón Duplicate o Remane para generar el nombre del nuevo tipo 
8. Asignar un nombre  

 
Cambiar la simbología a las líneas de nivel: 
 

9. En la caja de dialogo de propiedades de tipo desplegar la casilla Symbol y escoger 
el símbolo a usar.  
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10. Presionar el botón OK y observar el cambio en los símbolos de la línea de nivel. 

 
 
Ejes (Grids) 
 
Las líneas de rejilla son planos finitos. Sus extensiones se pueden arrastrar en vista de 
alzado para no intersecar líneas de nivel. Esto permite determinar si las líneas de rejilla 
aparecen en cada vista de plano nueva que se cree para un proyecto.  
 
Las rejillas pueden ser líneas rectas, arcos o multisegmento. Puede ocultar las líneas de 
rejilla después de añadirlas.  
  
Para crear Ejes: 
 

1. Activar una vista de planta, la que se encuentre en elevación de 0 o menos de 0 

2. Escoger pestaña Architecture => panel Datum => icono  (Grid) 
3. Definir punto inicial del eje 
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4. Definir punto final del eje 
 

 
 
Para definir la distancia entre ejes: 
 

1. Dibujar el primer eje, usando el procedimiento ya indicado. 
2. Sino está activo, activar el comando Grid, para dibujar ejes adicionales. 
3. Se activa la pestaña contextual Modify-Place Grid => en el panel Draw => escoger 

icono  (Pick Lines) 
4. En la barra de herramientas de opciones en la casilla offset escribir la distancia a 

la cual requiere colocar el nuevo eje (esto con respecto al eje que ya existe) 

 
5. Ubicar el puntero sobre el eje existente y asegurarse que el nuevo eje se proyecte 

sobre la dirección en la cual se requiere colocar. 

 
 

6. Hacer clic sobre el eje existente. 
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Ejes multisegmento 
 
Los ejes multisegmento permiten crear más de un segmento de línea haciendo la flexible 
la dirección y forma del eje, los segmentos de línea deben ir concatenados. 
 
Para crear ejes multisegmento: 

1. Escoger pestaña Architecture => panel Datum => icono  (Grid) 
2. Se activa la pestaña contextual Modify-Place Grid => en el panel Draw => escoger 

icono  
3. Dibujar el recorrido del eje 

 

4. Presionar el botón  (Finish Edit Mode) 
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Para crear ejes multisegmento adicionales: 
 

1. Seleccionar el eje multisegmento existente. 
2. Se activa la pestaña contextual Modify-Multi segmented Grid => en el panel Modify 

=> escoger icono (Copy). 
3. Hacer clic sobre un punto en el objeto que se va a definir como punto base de 

copia.  

 
 

4. Desplazar el puntero en la dirección en la cual se quiere generar el nuevo eje y 
escribir el valor de la distancia. 
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Capítulo 7 
 

Modelados de elementos compuestos (muros, pisos, cubiertas, 
plafones) 
 
La composición de un muro, piso, cubierta o plafón en Revit se va generando a partir de 
capas paralelas de materiales, estos materiales pueden ser un solo plano continuo con el 
mismo material o pueden tener diferentes materiales o compuestos sobre el mismo plano, 
como por ejemplo un muro que tiene una base de piedra de 90cms, y el resto del muro es 
de ladrillo rojo. Además, cada capa dentro del componente responde a un propósito 
particular.  Por ejemplo, algunas capas representan la estructura mientras que otras 
actúan como barreras termales.  Revit considera la función de cada capa y acopla a las 
capas apropiadamente.  Se puede representar cada capa fijando el material, el grueso, y 
la función de la capa.  El resultado sería una geometría compuesta con todos los 
materiales reales necesarios para definir el elemento compuesto. 
 
Los muros, pisos, cubiertas o plafones pueden estar compuestos de varias capas 
paralelas. Una capa puede consistir en un material continuo y único (como por ejemplo 
madera) o de múltiples materiales (como yeso, aislamientos, espacios de aire, envolturas 
etc). Adicionalmente cada capa en el componente tiene un propósito particular. Por 
ejemplo, algunas capas proveen soporte estructural, mientras otras actúan como barreras 
térmicas. 
 
Cada capa puede configurarse para que tenga su propia representación en cuanto al 
material, grosor y función. El detalle de las capas se puede observar en las vistas de 
planta, techo y corte modificando los niveles de detalle y estilos visuales.  
 
Modificar la estructura de un elemento compuesto  
 
Para modificar la estructura de un muro, piso, plafón o cubierta: 
 

1. Seleccionar el elemento que se requiere modificar 

2. En la caja de dialogo de propiedades, editar las propiedades de tipo  
3. En la opción Structure hacer clic sobre el botón Edit… 

 

 
 

4. En la caja de dialogo edición de ensamble, activar la visualización en modo de 

corte, haciendo clic sobre el botón . 
5. En la sección layers se listan todas las capas del elemento con sus características 

de función, materiales y grosor. 
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Para agregar una capa: 
 

1. Ingresar a las propiedades de tipo, hasta la estructura del elemento. 
2. Seleccionar una capa ya existente desde el número de ítem para identificar la 

ubicación de la nueva capa con respecto a la ya existente. 
 

 
 

3. Presionar el botón Insert  
 
Para asignar la función de la capa: 
 

1. Bajo la columna Function, seleccionar la capa de la cual se requiere cambiar la 
función y hacer clic sobre la opción Structure[1] 
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2. En el listado de opciones de función, escoger la que se requiere usar. 
 

Las funciones que se pueden asignar a las capas son las siguientes: 
 

Structure [1] - Forma la estructura principal  
Substrate [2] – Complementa la estructura con un sustrato 
Thermal/Air Layer [3] – function térmica 
Finish 1 [4] – Acabado exterior 
Finish 2 [5] – Acabado interior 
Membrane Layer - Membranas 

 
El número que aparece entre corchetes indica la jerarquía de las capas de acuerdo 
con la función. 
 
 

Asignación de materiales a elementos compuestos 
 

1. Seleccionar el elemento y entrar hasta las propiedades de tipo en la estructura. 
2. Si es necesario definir capas, grosor y función de capas en muro 
3. Bajo la columna Material, hacer clic sobre la casilla <By Category> 

correspondiente a la capa a la cual se quiere aplicar el material. 
4. Se despliega al lado derecho de la casilla un botón que muestra puntos 

suspensivos. 
 

 
 

5. Al hacer clic sobre el botón de punto suspensivos se despliega la caja de dialogo 
de materiales 

6. En la caja de dialogo Material Browser en la casilla de búsquedas, escribir las 
primeras letras referidas al material que busca. 
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7. Seleccionar en el listado el material que va a usar 
8. Hacer click derecho sobre el material seleccionado y en el submenú escoger la 

opción duplicar o renombrar. 
 

 
 

9. Asignar el nombre al nuevo material o en la pestaña Identity en la casilla Name 
puede asignar el nombre al material. 

 

 
 

10. Activar la pestaña Graphics. 
11. En la sección Shading hacer clic en la casilla Color, para seleccionar el color del 

sombreado para el material. 
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12. Ir a la sección Surface Pattern. 
 

 
 

13. En la opción Pattern, hacer clic sobre la representación del patrón de relleno y 
escoger el que se va a asignar a la capa cuando esta se observe en un nivel de 
detalle Fino y en una vista que muestre la superficie del objeto. 

14. Haciendo clic sobre la casilla Color, puede cambiar el color del patrón de relleno. 
15. Ir a la sección Cut Pattern. 
16. En la opción Pattern, hacer clic sobre la representación del patrón de relleno que 

se va a asignar a la capa cuando esta se observe en vistas donde el objeto se vea 
en modo de corte. Por ejemplo si el patrón de relleno es asignado a un muro, este 
se observará en las vistas de planta, pues en este tipo de vista el muro aparece en 
corte. 
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17. Haciendo clic sobre la casilla Color, puede cambiar el color del patrón de relleno 
18. Hacer clic en Ok para aceptar los cambios y salir del cuadro de dialogo.  

 
Para activar la visibilidad de las capas en vistas: 
 

1. En la barra de herramientas de controles => desplegar el icono Detail Level => 

escoger opción . 
 

 
Muros básicos y apilados 
 
Al igual que otros elementos básicos de un modelo de construcción, los muros son 
ejemplares de tipos de familia de sistema predefinidos que representan variedades 
estándar de función, composición y grosor de muros. 

 
Justificación de muros  
 
En los muros básicos y apilados la función Location Line permite especificar el plano 
vertical que será usado para posicionar el muro en relación con la trayectoria. Cuando un 
muro es generado en base a un elemento existente, la justificación será determinada por 
el valor que sea seleccionado en la casilla Location line que está en la barra de 
herramientas de opciones.  Las opciones para determinar el plano de colocación del muro 
son: 
 

• Wall Center line: (Opción por defecto) 

• Core Centerline 

• Finish Face: Exterior 

• Finish Face: Interior 

• Core Face: Exterior 

• Core Face: Interior 
 
El término Core tiene que ver con la estructura principal de capas del muro. Básicamente 
es la capa que separa la estructura y los acabados, esta capa generalmente tiene grosor 
de 0. 
 
Crear muros básicos o apilados 
 
Para crear un muro básico o apilado: 
 

1. Colocar activa una vista de planta o 3D. 

2. Escoger pestaña Architecture => Panel Build =>  (Wall) 
3. En las propiedades, en la casilla Type selector, seleccionar el tipo de muro. 
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4. Escoger pestaña contextual Modify – Place Wall => Panel Draw, seleccionar el 
modo de dibujo (si es línea, arcos, círculos etc.). 

 

 
 

5. En la barra de herramientas de opciones definir altura (Height) del muro y la 
justificación (Location Line). 

 

 
 

6. Hacer click sobre la vista en el primer punto para definir el inicio del muro. 
7. Definir el segundo punto del muro. 

 
 
Modificar propiedades de muros básicos y apilados 
 
Los muros pueden modificarse, ya sea para cambiarlos de tipo o familia, estructura, nivel 
o altura, desde la paleta de propiedades. 
 
Para modificar altura de un muro: 
 

1. Seleccionar el muro o muros a modificar: 
2. En la paleta de propiedades en las propiedades de instancia, modificar las casillas: 

 
Base Constrain: define el nivel donde comienza el muro (altura base del muro)  
Top Constrain: define el nivel donde termina el muro (determina la altura total del 
muro) 
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Para cambiar el tipo de muro: 
 

1. En la vista actual, seleccionar el muro a cambiar de tipo 
2. En la paleta de propiedades, desplegar el selector de tipo y escoger el tipo de 

muro. 
 

 
  

 
Editar el perfil de un muro básico o apilado 
 
La forma de los muros puede ser editada a través de la herramienta editar perfil. Con este 
comando los elementos se activan en modo de boceto, lo cual permite agregar o eliminar 
vértices, o se cambia la forma en los bordes.  
 
En la mayoría de los casos, cuando se coloca un muro recto, este tiene un perfil 
rectangular cuando se visualiza en alzados que se ven perpendiculares a su longitud. Si el 
diseño requiere una forma de perfil diferente, o si desea crear huecos en el muro, puede 
editar el perfil de alzado del muro en una vista de alzado o en sección. 
 
 
Para editar el perfil de un muro: 
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1. Activar una vista de elevación, sección o 3D 
2. Seleccionar el muro a editar 

3. En la pestaña contextual Modify Wall => Panel Mode =>  (edit Profile) 
4. El muro muestra el perfil en líneas primitivas 

 

 
 

5. En caso de que se requiera cambiar la forma del muro eliminar los segmentos 
lineales a remplazar. 

6. Usando las herramientas del panel Draw, cambiar la forma del muro modificando 
las líneas de sketch.  

 

• Al realizar modificaciones al perfil debe asegurarse de que las líneas del sketch 
cierren correctamente el área. 

• Cualquier boceto cerrado que se dibuje dentro del sketch del muro se 
convertirá en un hueco. 
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7. Finalizar la edición del perfil  (Finish Edit Mode) 
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Para eliminar la modificación realizada al perfil del muro: 
 

1. Seleccionar el muro 

2. En la pestaña contextual Modify Wall => Panel Mode => icono  
 
 
Muros apilados 
 
La familia de muros apilados consiste en 2 o más muros básicos que se colocan uno 
sobre otro. 
 
Para crear un muro apilado: 
 

1. Previamente debe crear los tipos de muros básicos que va a usar para definir la 
estructura del muro apilado. 

2. Escoger pestaña Architecture => panel Build => icono  (Wall) 
3. En la paleta de propiedades desplegar el selector de tipos buscar y seleccionar la 

familia Stacked Wall  
4. Seleccionar un tipo de muro apilado, bajo el grupo de familias Stacked wall. 
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5. En las propiedades de tipo sacar un duplicado o renombrar el muro y asignarle un 
nombre. 

6. Bajo los parámetros de construcción hacer clic en el botón Edit… que esta frente a 
la opción Structure 

7. En la caja de dialogo Edit Assembly, bajo la sección Types se despliega el listado 
de muros básicos que están conformando actualmente el muro apilado. 

 

 
 

8. Para agregar un nuevo segmento al muro, presionar el botón Insert. 
9. Usando los botones Up y Down puede ordenar la forma en cómo se disponen los 

segmentos de muro uno sobre otro. 
10. Al presionar el botón Preview puede observar un corte del muro. 
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11. Bajo la columna Height debe establecer la altura de cada segmento de muro.  
12. Hay un muro que siempre muestra el valor Variable en la altura, este valor no se 

puede modificar, pues la altura de este segmento se va a adaptando para ajustar 
la altura total del muro. 

13. La opción Flip permite cambiar la dirección del segmento de muro. 
 

 
       

14. La opción Offset permite desfasar el segmento de muro con respecto al punto de 
origen. 
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Cambio de orientación de muros 

Cuando se utiliza la barra espaciadora o los controles de volteo en pantalla cambia la 
orientación interior/exterior de un muro, el eje alrededor del cual se voltea el muro, es la 
línea de ubicación. Por lo tanto, si se cambia la orientación, puede que también cambie la 
posición del muro.  
 
Para cambiar la orientación de un muro: 
 

1. Seleccionar el muro a cambiar de orientación  

2. Presionar la barra espaciadora o hacer clic sobre los controles  
 

 
Sketching (modo boceto) 
 
El dibujo de bocetos (Sketch) es el procedimiento utilizado para dibujar elementos en Revit. 
Entre los elementos basados en bocetos se incluyen pisos, techos y extrusiones. 
También hay elementos (por ejemplo, muros) que se dibujan como bocetos, pero no 
requieren el uso del modo de boceto.  
 
El modo de boceto es un entorno en Revit que permite crear bocetos de elementos cuyo 
tamaño o forma no se puede determinar automáticamente, por ejemplo, al crear una 
cubierta o un piso (o al editar un boceto de uno de esos elementos). Cuando se activa el 
modo de boceto, la cinta de opciones muestra las herramientas necesarias para el tipo de 
boceto que se va a crear o editar.  
Todos los elementos que forman un elemento basado en boceto (por ejemplo, una 
cubierta) constituyen el boceto. 
Las opciones para creación de bocetos son: 
 

Opciones de dibujo     
Permite dibujar bocetos usando o combinando elementos como líneas, rectángulos, 
polígonos, arcos, splines o elipses. 
 

Selección de objetos   
Permite seleccionar muros, líneas o bordes existentes. Cuando se usa Seleccionar líneas, 
en la barra de opciones está disponible (para algunos elementos) la opción Bloquear, que 
fija la línea seleccionada al borde. 
 

Selección de muros  
Permite seleccionar muros para crear los elementos del boceto 
 

Pisos 
 
Los pisos pueden crearse a partir de perfiles bosquejados o utilizando los muros 
envolventes que definen el piso. Normalmente, se dibuja un boceto de un piso en una 
vista de planta, aunque se puede hacer en una vista 3D si el plano de trabajo de la vista 
3D se establece en el plano de trabajo de una vista de planta. 
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Para crear pisos: 
 

1. Activar una vista de planta en la cual se va a colocar el piso 

2. Escoger pestaña Architecture => Panel Build => icono  (Floor) 
 
 

3. En las propiedades de tipo  escoger el tipo de piso desde la casilla 
Type. 

 

 
 

 
4. Al igual que los muros, los pisos pueden tener una estructura compuesta basada 

en capas. Para revisar y/o editar la estructura de un piso, hacer clic sobre el botón 
Edit que se encuentra frente a la opción Structure bajo el grupo de parámetros 
Construction. 

 

 
 

5. En el panel Draw seleccionar las herramientas de dibujo a utilizar para definir el 
perfil del piso. 
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6. Definir el contorno del piso  
 

 
 

7. Para crear el piso presionar icono Finish Edit Mode 
 

 
 
Modificar el contorno de un piso 
 
Para modificar el contorno de un piso se debe ingresar en modo de boceto. 
 
Para modificar el contorno de un piso: 
 

1. Activar una vista de planta 

2. En la pestaña contextual Modify Floor => Panel Mode => icono  
3. Realizar las modificaciones requeridas al contorno del piso. 

 

• Al realizar modificaciones al perfil debe asegurarse de que las líneas del 
sketch cierren correctamente el área. 

• Cualquier boceto cerrado que se dibuje dentro del sketch del piso se 
convertirá en un hueco. 
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4. Al terminar la modificación hacer click en el icono  (Finish Edit Mode) 
 
Asignar una pendiente a un piso 
 
A los pisos se les puede establecer una pendiente, utilizando una flecha de inclinación, 
que permite definir una altura inicial y una altura final sobre el nivel. 
 
Para asignar una pendiente a un piso: 
 

1. Seleccionar el piso  

2. En la pestaña contextual Modify Floor => escoger icono  (Edit Boundary) 
3. En la pestaña contextual Modify Floor – Edit Boundary => escoger icono 

 
4. Definir punto inicial y punto final de la flecha de pendiente. Se debe dibujar la 

flecha de pendiente en la dirección de la inclinación. 
 

 
 

5. Manteniendo seleccionada la flecha de pendiente, en las propiedades de instancia, 
En la opción Specify está seleccionada por defecto la opción Height at Tail, lo 
cual permite definir la altura inicial y final de la pendiente del piso con respecto al 
nivel. 
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6. También, En la opción Specify puede seleccionar la opción Slope, e ingresar un 

ángulo de pendiente. 
 

 
 

7. Presiona el botón  (Finish Edit mode), para terminar el comando. 
 
Agregar subelementos a pisos 
 
Puede usar la herramienta de modificar subelementos para manipular una o más puntos o 
ejes sobre el piso. Puede agregar nodos y asignarles una elevación específica. 
 
Para agregar líneas de división a pisos: 
 

1. Seleccionar el piso . 
2. En la pestaña contextual Modify – Floor => panel Shape Editing  => escoger icono 

 
3. Dibujar la línea de división. 
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Para agregar nodos: 
 

1. Seleccionar el piso. 
2. En la pestaña contextual Modify – Floor => panel Shape Editing => escoger icono 

 
3. Hacer clic en el sitio donde será colocado el nodo (ya sea en el contorno o área de 

piso) 
 

 
 
Para modificar altura de los nodos: 
 

1. Seleccionar el piso 
2. En la pestaña contextual Modify – Floor => panel Shape Editing => escoger icono 

 (Modify Sub elements). 
3. Seleccionar el nodo al cual requiere cambiar la elevación. 
4. Cambiar el valor actual de elevación. 
5. Si necesita cambiar la elevación de otros nodos realizar el mismo procedimiento. 
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Para eliminar los cambios realizados en la forma de un piso: 
 

1. Seleccionar el piso. 
2. En la pestaña contextual Modify – Floor => panel Shape Editing => escoger icono 

 (Reset Shape). 
 
 

Cubiertas (Azoteas)  
 
Hay varios métodos de crear las azoteas en Revit, el método foot print y extrusión. Sin 
importar cuál sea el método de creación, Revit permite al usuario la creación de sistemas 
complejos de azoteas que pueden incluir pendientes o una composición de lozas 
inclinadas, planas, o de forma libre.  Además, las losas permiten crear recortes uniones 
con otras losas y unir automáticamente los muros con las losas no importando la forma de 
estas.   
 

 
 
 
 
Método Foot print  
 
La creación con este método se realiza a partir de un bosquejo en 2D que define el 
perímetro del techo, El bosquejo se realiza con líneas arcos etc. en modo de sketch, o 
también pueden tocarse los muros perimetrales que definen la forma del techo. 
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El bosquejo debe contener una sección cerrada que representa el exterior de la cubierta y 
también puede contener otros perfiles cerrados dentro del perímetro.  Los perfiles internos 
definen huecos.  También se pueden ir definiendo las pendientes utilizando las marcas de 
ángulo que aparecen en los bordes de los planos. 
 
Para crear una cubierta por método Foot print: 
 

1. Activar la vista de planta donde se creará la cubierta 

2. Escoger pestaña Architecture => Panel Build => desplegar icono  => opción 

 

3. En las propiedades de tipo  escoger el tipo de cubierta 
4. Bajo los parámetros de construcción en la casilla Structure, presionar el botón 

Editar para verificar o modificar la estructura. 
 

  
 

 
5. Escoger la pestaña contextual Modify Create Roof Footprint => panel Draw  

escoger las herramientas requeridas para crear el sketch de la cubierta. 
 

 
  

 
6. En la barra de herramientas de opciones configurar las opciones para creación de 

la cubierta. 
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• La opción Defines Slope; cuando esta activada crea caras inclinadas y 
desactivada define caras planas. 

• En Overhang debe escribir la distancia del bolado  
 

7. Dibujar o seleccionar los elementos para definir el perfil de la cubierta 
 

 
  

Los segmentos del perfil que muestran un signo de ángulo formarán caras 
inclinadas. Los que no tienen marca, formarán caras planas. 

 
8. Editar el ángulo de inclinación si es necesario, seleccionando un segmento. 

 

 
 

9. Presionar botón  Finish Edit Mode, para crear la cubierta. 
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Asignar pendiente a una cubierta 
 

1. Seguir el procedimiento indicado anteriormente para creación de cubiertas con 
método Footprint hasta el paso número 8. 

2. Seleccionar la cubierta. 
3. Escoger la pestaña contextual Modify Create Roof Footprint => panel Draw 

escoger la opción . 
4. Dibujar la flecha de pendiente tomando en cuenta la dirección para la inclinación. 

 

 
 

5. Seleccionar la flecha de pendiente y en las propiedades establecer la altura inicial 
(Height Offset at tail) y final (Height Offset at Head) de la pendiente. 

 

 
 

6. La opción Specify permite esocger el valor Slope, para definir la pendiente en 
grados. 
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7. Presionar botón  Finish Edit Mode, para crear la cubierta. 
 

 
 
 
Agregar flecha de pendiente a las caras de una cubierta 
 
La herramienta Slope Arrow (Flecha de pendiente) permite asignar una pendiente a una 
cara en específico. 
 
Para agregar una flecha de pendiente: 
 

1. Seleccionar la cubierta 

2. Escoger la pestaña contextual Modify Roof => panel  

3. En el Panel Draw escoger icono  (Slope Arrow) 
4. Sobre la línea del sketch que corresponde a la cara a modificar, definir el punto 

inicial y luego el punto final (tomando en cuenta la dirección de la inclinación) 
 

 
 

5. En las propiedades de instancia en las casillas correspondientes se debe 
configurar, la altura inicial y final o la pendiente. 
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6. Presionar el botón (Finish Edit Mode). 
 

 
 
 
Crear cubiertas con método de extrusión 
 
Con este método se debe crear un perfil en un plano frontal o posterior al edificio, luego 
se convierte en una extrusión  indicando una longitud específica, el perfil se creará con 
líneas y arcos que se conectan entre ellos y que forman un perfil no cerrado. La altura de 
la cubierta va a depender del nivel en que se dibuja y la altura del perfil creado. 
 
Para crear una cubierta por método de extrusión: 
 

1. Activar una vista de planta para establecer un plano de referencia 

2. Escoger pestaña Architecture => panel Work plane => icono  
3. Dibujar la línea de plano de referencia, definiendo un punto inicial y uno final. 

 

 
La línea de referencia determina el plano de trabajo y origen para dibujar un 
boceto sobre una vista de elevación o corte.  

4. Escoger pestaña Architecture => panel work plane => icono , para activar 
el plano de trabajo vinculado a la línea de referencia. 



120 
 

5. En la caja de dialogo Work Plane escoger opción . 
6. Presionar el botón OK. 
7. Seleccionar línea de referencia. 
8. En el listado de vistas de fachada, escoger la vista sobre la cual se requiere 

trabajar (una sección o elevación). 

9. Escoger pestaña Architecture => Panel Build => icono  
10. En la caja de dialogo Referencia de nivel y desfase, seleccionar el nivel al cual se 

va  a vincular la cubierta. 
11. Definir el tipo de cubierta, y la estructura si es necesario. 
12. Dibujar el perfil no cerrado. 

 
 

 
 

13. Presionar botón  Finish Edit Mode, para crear la cubierta. 
 

 
 
 
 
Vincular muros a cubierta 
 
Al vincular los muros con la cubierta, los muros se adaptarán automáticamente a cualquier 
cambio realizado sobre la cubierta para ajustar el modelo. 
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Para vincular muros a una cubierta: 
 

1. Seleccionar el muro o muros 
2. En la pestaña contextual Modify Wall => panel Modify Wall => escoger icono 

 (Attach Top/base). 
3. Seleccionar la cubierta y observar que los muros se ajusten de acuerdo a la forma 

y altura de la cubierta. 
 
 

Plafones (Ceiling) 
 
Los plafones pueden ser creados a partir de un contorno formado por muros que estén 
dispuestos en un área cerrada, o dibujando un boceto. Los plafones se crean en las vistas 
de techo (Ceiling). 
 
Los componentes Ceiling generalmente se usan para definir plafones o losas de 
entrepiso.    
 

 
 
Para crear plafones: 
 

1. En el Project Browser bajo la sección Ceiling Plans, seleccionar la vista para 
colocar el plafón. 

2. Escoger pestaña Architecture => Panel Build =>  
3. La pestaña contextual Modify Place Ceiling => panel Ceiling, muestra dos 

opciones . 
 

4. Seleccionar Automatic Ceiling, si desea que el programa determine 
automáticamente las areas para el plafón (deben existir muros conformando un 
área cerrada), o puede Seleccionar la opción Sketch Ceiling, si desea dibujar el 
boceto para el plafón. 
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5. En las propiedades de instancia, ingresar el valor de altura sobre el nivel en la 
opción Height Offset Fron Level. 

 

 
 
 

6. En las propiedades tipo , seleccionar el tipo de plafón y revisar o 
modificar la estructura. 
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7. Presionar botón  Finish Edit Mode, para crear el plafón. 
 
 

Muros de Cristal (Curtain Wall) 
 
Un muro curtain o de cristal es cualquier muro exterior enlazado a la estructura del edificio 
y que no dirige las cargas del suelo o de la cubierta del edificio.  
En el uso habitual, los muros curtain se suelen definir como muros delgados, 
normalmente muros con marcos de aluminio que contienen rellenos de cristal, paneles 
metálicos o piedra.  
 
En un muro curtain, las líneas de rejilla definen el lugar donde se colocan los montantes. 
Los montantes son elementos estructurales que dividen unidades de ventana adyacentes. 
Es posible modificar los tipos de muro curtain por defecto. Estos tipos de muro 
proporcionan tres niveles de complejidad, los cuales se pueden simplificar o mejorar:  
 

• Muro curtain (Curtain wall): no tiene rejillas ni montantes. Este tipo de muro no 
tiene reglas asociadas, es más flexible.  

• Cristalera exterior (Exterior Glazing): tiene rejillas predefinidas. Es posible cambiar 
las reglas de rejilla.  

• Escaparate (Storefront): tiene rejillas y montantes predefinidos. Es posible cambiar 
las reglas de rejilla y montante.  
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Configurar y crear un muro curtain 

1. Escoger pestaña Architecture => panel Build => icono (Wall) 
2. En la paleta de propiedades, en el selector de tipos, navegar hasta la familia 

Curtain Wall 
3. Escoger el tipo de muro curtain que se quiere usar. 

 

 
 

4. Se activa la pestaña contextual Modify – Place Wall => en el panel Draw => 
escoger la opción de dibujo a usar. 

 

 
 

5. En la barra de herramientas de opciones definir a la altura del muro escogiendo 
Height para configurar la altura y luego seleccionar el nivel o ingresar el valor de 
altura para el muro. 

 

 
 

6. En la paleta de propiedades, en las propiedades tipo debe definir el tamaño de los 
paneles de Cristal. 
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• En la sección Vertical Grid Pattern se define el ancho de los paneles de 
cristal.  

• En la sección Horizontal Grid Pattern se define la altura de los paneles de 
cristal. 

 
7. Adicionalmente se puede agregar cancelería o perfiles de aluminio o madera a las 

divisiones o juntas de los paneles de cristal. 
 

 
 

• En la sección Vertical Mullions se configura la colocación de la cancelería en 
las divisiones verticales del muro curtain.  

• En la sección Horizontal Mullions se configura la colocación de la cancelería 
en las divisiones horizontales del muro curtain. 

• Las opciones Interior Type permiten colocar la cancelería en las divisiones 
interiores y Border Type 1 y 2 en los bordes de los muros. 

 
8. Dibujar el muro, escogiendo las herramientas disponibles en el panel Draw. 
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Fusionar paneles en un muro de cristal 
 

1. Sin seleccionar el muro, ubicar el puntero sobre la división que se quiere eliminar.  
En cada división del muro se muestra una línea punteada de color azul que es la 
que marca la división. 

 
 

  
 

2. Hacer clic sobre la línea punteada. 
3. Se activa la pestaña contextual Modify – Curtain Wall Grids => en el panel Curtain. 

Grid => escoger icono  (Add/Remove Segments). 
4. Hacer clic nuevamente sobre la línea pundeada en el sitio donde se quiere eliminar 

la división. 
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Para agregar divisiones en un muro de cristal: 

1. Escoger la pestaña Architecture => panel Build => icono  (Curtain Grid) 
2. Se activa la pestaña Contextual Modify – Place Curtain Grid => en el panel 

Placement escoger la opción dependiendo de cuantos paneles se requieren dividir. 
 

 
 

3. Ubicarse sobre el borde del panel que se quiere dividir y hacer clic para crear la 
división.  

 

 
 

Seleccionar un panel de cristal 
 
En los muros curtain no es posible insertar elementos como puertas o ventanas, por lo 
tanto será necesario reemplazar un panel de cristal por estos elementos, para poder 
seleccionar un panel de cristal se deben seguir los pasos indicados a continuación: 

 
1. Ubicar el puntero sobre el borde del panel sin seleccionarlo. 
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2. Presionar la tecla TAB del teclado hasta que el panel se resalte. 
 

 
3. Hacer click sobre el panel para seleccionarlo. 

 

 
 

 
Para insertar una puerta en un muro de cristal 
 

1. Usando las funciones de dividir y fusionar adaptar el panel de cristal al tamaño de 
la puerta. 

2. Seleccionar el panel de cristal a remplazar por la puerta. 
3. En la paleta de propiedades, en las propiedades de tipo, presionar el botón Load. 
4. En las librerías métricas en la carpeta puertas, escoger cualquiera de las familias 

de puertas para muros de cristal, que son las familias que se muestran en el 
listado a continuación. 
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5. Cambiar el nombre del tipo de puerta si es necesario.  
6. Presionar el botón OK. 

 

 
 

 
Para remplazar un panel de cristal por un panel vacío o sólido 
 

1. Seleccionar el panel a remplazar. 
2. En la paleta de propiedades desplegar el selector de tipos, escoger el tipo Empty, 

para cambiar el panel de cristal por un panel vacío y el tipo Solid, para cambiarlo 
por un panel sólido. 

 

Escaleras 
 
Puede crear escaleras en una vista en planta mediante la definición de recorrido (Run) o 
dibujar líneas de eje vertical y líneas de contorno. Puede definir el recorrido directamente, 
en forma de L con una plataforma, en forma de U o espiral. También puede modificar el 
límite exterior de la escalera modificando las líneas de contorno. Las huellas y 
contrahuellas se actualizan automáticamente. Revit Architecture también genera 
automáticamente los pasamanos de las escaleras. En edificios de varios pisos, puede 
diseñar un conjunto de escaleras y ampliar juegos idénticos hasta el nivel más alto. 
 
Las escaleras por recorridos tienen opciones de creación ya predefinidas que son: forma 
U, L, lineales, espirales cerrados y abiertos. 
 
Una escalera puede constar de los siguientes elementos:  
 

• Tramos: rectos, espirales, en U, en L, boceto de tramo personalizado.  
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• Descansillos: creados automáticamente entre tramos, mediante la selección de 
dos tramos o mediante la creación de un boceto de descansillo personalizado. 

• Soportes (laterales y centrales): creados automáticamente con los tramos o 
mediante la selección de un borde de tramo o descansillo.  

• Barandales: generadas automáticamente durante la creación o colocadas 
posteriormente.  

 
Tipos de escaleras 
 
Existen tres familias predefinidas de escaleras: Escalera moldeada in situ (Cast-In-Place), 
Escalera prefabricada (Precast) y Escalera ensamblada (Assembled). Las diferencias 
entre las tres familias se indican a continuación: 
 
Escalera moldeada in situ: tramo y descansillo monolíticos.  
 

 
 
Escalera prefabricada: conexión de entalladura. 
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Escalera ensamblada: ejemplo tramo no monolítico y descansillo no monolítico 
 

 
 
 
Puede crear escaleras a partir de componentes individuales, utilizando las herramientas 
de componentes de tramo para crear tramos comunes, como, por ejemplo, tramos rectos 
(Lineal), en arco, en espiral o de peldaños compensados (L) y forma de U. 
 
Escaleras con recorrido lineal 
 
Para crear escaleras por recorrido lineal: 

1. Escoger pestaña Architecture => Panel Circulation =>   
2. En la pestaña contextual Modify-Create Stair => panel Components escoger icono 

(Straight) 
3. En la barra de herramientas de opciones escoger la justificación de la escalera en 

la opción Location Line. 
 

 
 

4. En la paleta de propiedades en el selector de tipos, escoger el tipo de escalera 
5. En las propiedades de tipo los parámetros más importantes a configurar son: 

 

• Minimum Run With – define el acho de la escalera 

• Minimum Tread Depth – mínima profundidad de huella 

• Maximum Riser Height – Máxima altura de escalón 
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6. En las propiedades de instancia definir:  
 

• Base Level – nivel base 

• Top Level – nivel superior 

• Actual Tread Depth – Profundidad de huella actual 
 

 
 

7. Definir punto inicial y luego el punto final de la escalera 
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8. Hacer clic en el botón  (finish Edit Mode) 
 
 
Escaleras en espiral 
 
Para crear una escalera en espiral: 

1. Escoger pestaña Architecture => Panel Circulation =>   
2. En la pestaña contextual Modify-Create Stair => panel Components escoger icono 

 (Full Step Spiral). 
3. En la barra de herramientas de opciones escoger la justificación de la escalera.  
4. En la paleta de propiedades en el selector de tipos, escoger el tipo de escalera. 
5. En las propiedades de tipo los parámetros más importantes a configurar son: 

 

• Minimum Run With – define el acho de la escalera 

• Minimum Tread Depth – mínima profundidad de huella 

• Maximum Riser Height – Máxima altura de escalón 
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9. En las propiedades de instancia definir:  
 

• Base Level – nivel base 

• Top Level – nivel superior 

• Actual Tread Depth – Profundidad de huella actual 
 

 
 

10. Para dibujar una escalera en espiral se debe definir el punto centro de la 
circunferencia. 
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11. Luego indicar el radio de la espiral. 
 

 
 

12. Hacer clic sobre el punto donde inicia el punto de subida de la escalera. 
 

 
 
Crear escaleras que se conectan con un descanso 
 

1. Escoger pestaña Architecture => Panel Circulation =>   
2. En la pestaña contextual Modify-Create Stair => panel Components escoger la 

opción de escalera según el modelo a crear, por ejemplo, una escalera en L. 
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3. Crear la escalera. 
4. En el panel Components seleccionar el tipo de escalera adicional a colocar, por 

ejemplo, una escalera lineal. 
5. Asegurarse que en la barra de herramientas de opciones la opción Automatic 

Landing este activada . 
6. Ubicar el puntero de tal forma que quede alineado con la escalera dibujada en el 

paso anterior a la distancia requerida. 
 

 
 

7. Definir punto inicial y luego punto final para la escalera a conectar 

 
 

8. Hacer clic sobre el botón  (Finish Edit Mode) para salir del comando y que la 
escalera sea creada. 

 
 
Para crear una escalera definiendo el recorrido 

1. Escoger pestaña Architecture => Panel Circulación => icono  (Stair) 

2. En el panel Components escoger icono (Run) 



137 
 

3. En la barra de herramientas de opciones configurar las opciones correspondientes: 
 

• Location Line: indica el lado (izquierda, derecha, centro) que se usará como 
referencia para dibujar la escalera. 

• Actual Run Width: se define el ancho de la escalera  
 

 
 

4. Definir el punto inicial de la escalera. 
 

 
 

5. Definir el segundo punto de la escalera alineándola con un punto especifico o con 
una huella de las ya generadas. 

 

 
 

6. Definir último punto. 
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7. Presionar el botón (Finish Edit Mode) 
 
Para modificar la cantidad de escalones en una escalera tipo Run: 
 

1. Seleccionar la escalera desde una vista de planta 

2. En la pestaña Contextual Modify Stairs => panel Edit => escoger icono  (Edit 
Stairs) 

3. Seleccionar la escalera por el lado que se quiere modificar, desde la guía que va 
en dirección de las huellas. 

 
 
Para modificar el ancho de la escalera de un solo lado en una escalera tipo Run: 
 

1. Seleccionar la escalera desde una vista de planta 

2. En la pestaña Contextual Modify Stairs => panel Edit => escoger icono  (Edit 
Stairs). 

3. Seleccionar la escalera del lado que se requiere modificar. 
4. Cambiar el valor de la cota temporal, por el nuevo valor. 
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Para modificar el perfil de una escalera: 
 
Para modificar el contorno, huellas y descanso de las escaleras que han sido creadas 

utilizando las funciones de formas comunes , hay que conviertirlas en 
bocetos. 
 

1. Seleccionar la escalera a modificar 

2. En la pestaña contextual Modify Stairs => panel Edit => escoger icono   (Edit 
Stairs) 

3. Seleccionar nuevamente la escalera  
 

 
 

4. En la pestaña contextual Modify-Create Stair =>panel tools=> escoger icono 

 (Convert). 
 

5. Seleccionar nuevamente la escalera 
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6. En la pestaña contextual Modify-Create Stair =>panel tools=> escoger icono  
(Edit Sketch) 
 

7. Realizar las modificaciones requeridas en el boceto. 
 

8. Presionar el botón (Finish Edit Mode) 

 

Crear escaleras a partir de bocetos (Sketch) 
 
Existe un modo que permite crear el boceto de tramos, descansos y huellas de forma 
independiente. Una vez que se han realizado los bocetos, estos componentes se pueden 
conectar para crear un montaje de escalera. 
 
Cuando se crean componentes mediante bocetos, no se establece de forma automática la 
relación entre los elementos, tal y como sucede cuando estos se crean con las 
herramientas de componentes comunes. Por ejemplo, cuando se crean bocetos de 
componentes de tramo, descansos y huellas y se cambia la anchura del tramo, la forma 
de la huella o del descanso no se modifica de forma automática. Los componentes 
creados mediante bocetos se deben actualizar de forma manual.  
 
Para crear escaleras a partir de bocetos: 
 

1. Activar la vista en planta 

2. Escoger pestaña Architecture => Panel Circulation => icono   => en el 

panel Components escoger opción   (Create Sketch) 
3. Escoger pestaña contextual Modify Create Stairs Sketch => Panel Draw => icono 

 
4. Dibujar las líneas de contorno. Las líneas de contorno son de color verde.  
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5. Escoger pestaña contextual Modify Create Stairs Sketch => Panel Draw => icono 

 
6. Dibujar las líneas que representan los huellas y descansos. Estas líneas de 

representan de color negro. 
 

 
 

7. En el panel Draw, escoger icono  (Stair Path). Trazar segmentos de 
línea indicando la trayectoría del recorrido de la escalera. 

 
 

8. En las propiedades de tipo  determinar: tipo de escalera, máximo valor 
para altura de escalon (peralte) y máximo valor para profundidad de huella. 
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9. Escoger panel Tools => icono  (Railing Type), para seleccionar un barandal 

10. Finalizar la creación de escalera haciendo clic sobre icono (Finish edit mode) 
 

 
 
Modificar el perfil de una escalera creada a partir de un boceto: 
 

1. Activar una vista de planta y seleccionar la escalera 
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2. En la pestaña contextual Modify Stairs => panel Edit => escoger icono   (Edit 
Stairs) 

3. Seleccionar la escalera. 
4. En la pestaña contextual Modify-Create Stair =>panel tools=> escoger icono 

 (Edit Sketch) 
 

5. Realizar las modificaciones requeridas en el boceto 
 

 
 

11. Finalizar los cambios de la escalera haciendo clic sobre icono   
 
Reglas de cálculo para crear escaleras 
 
Las siguientes son las reglas de cálculo que usa Revit para crear escaleras. 
 
Riser + Tread = 17.5 inches: 7.5 inches for the riser height; 10 inches for the tread depth.  
Riser * Tread = 75 inches.  
2(Riser) + Tread is greater than or equal to 24 inches (minimum threshold) or less than or 
equal to 25 inches (maximum threshold). 
 
Para ver las reglas de cálculo de escaleras: 
 

1. Seleccionar la escalera 
2. Entrar a las propiedades tipo de la escalera  
3. Bajo la sección Construction, se encuentra la casilla Calculation Rulers 
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Ajustes de componentes de escaleras 
 
Se pueden modificar las propiedades de huellas, contrahuellas, soportes y materiales de 
las escaleras. Estas modificaciones aplican a las tres familias de escaleras existentes en 
Revit, sin embargo, los cambios pueden afectar de diferentes maneras dependiendo de la 
familia que se esté modificando. 
 
Para Modificar las propiedades de los peldaños: 
 

1. Seleccionar la escalera. 
2. Entrar a las propiedades de Tipo. 
3. Bajo el grupo de parámetros Construction, buscar la opción Run Type y hacer clic 

sobre la casilla que está frente a la opción, se despliega un botón  con puntos 
suspensivos. 

 

 
 

4. Bajo el grupo de parámetros Tread, se encuentran las opciones que permiten 
modificar las características de los componentes de las huellas. 

 

 
 
            

• Tread thickness: Especifica el grosor de la huella.   

• Tread Profile: perfil usado para representar huella. 

• Nosing Length: Especifica la cantidad de huella que sobresale de la siguiente 
huella. 

• Nosing Profile:  El perfil de un barrido añadido a la parte frontal o a los laterales 
de la huella. 
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5. Bajo el grupo de parámetros Risers, se encuentran las opciones que permiten 
modificar las propiedades de las contrahuellas. 

 

  
 

• Riser: Activa o desactiva la opción de visualizar la contrahuella de la escalera 

• Slanted: Activa o desactiva la inclinación de la contrahuella 

• Riser Thickness: permite colocar un grosor a la contrahuella 

• Riser Profile: indicar el perfil usado para representar la contrahuella 

• Riser to Tread Connection: contiene tres opciones que indican como se 
conectan huella y contrahuella. 

 
Para modificar las propiedades de los soportes: 
 

1. Seleccionar la escalera. 
2. Entrar a las propiedades de Tipo. 
3. Bajo el grupo de parámetros Supports, están las opciones para activar, desactivar 

o modificar los soportes de izquierda, derecha o centro de la escalera. 
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4. Las casillas Right y Left Support tienen tres opciones que permiten modificar la 

visualización de los soportes sobre las escaleras. 
 

 
 

 
 

 
 

 
5. La Opción Middle Support permite activar o desactivar la colocación de soporte en 

el centro de la escalera. 
 

 



147 
 

 
6. Al hacer clic sobre las casillas que están frente a las opciones Right, Left, Middle 

support Type, se muestra el botón , permite entrar a las propiedades del perfil 
que se está usando para los soportes y realizar modificaciones de dimensiones y 
materiales. 

 

 
 
 
Convertir una escalera en multinivel: 
 

1. Activar una vista de Sección, Elevación o 3D donde estén visibles las líneas de 
nivel del proyecto. 

2. Seleccionar la escalera. 
3. En la pestaña contextual Modify-Stairs => panel Multistory Stair => escoger icono 

 (Select Levels). 

4. Verificar que el icono  (Connect Levels) esté activo, es decir resaltado de 
color azul. 

5. Seleccionar las líneas de nivel correspondientes a los niveles donde se requiere 
crear las escaleras. Tomar en cuenta que los niveles deben tener una altura 
idéntica a la del nivel donde fue creada originalmente la escalera a convertir en 
multinivel. 
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6. Presionar el botón Finish  
 

 
 
 

Rampas 
 
El procedimiento para crear rampas es muy parecido al de creación de escaleras. Las 
rampas pueden tener diferentes formas y se pueden crear en vistas en planta o 3D. 
Las herramientas y los procedimientos utilizados para realizar bocetos de rampas son los 
mismos que se utilizan para realizar bocetos de escaleras. Al igual que con las escaleras, 
es posible definir tramos rectos, tramos en L, rampas en U y rampas en espiral. También 
se puede modificar el contorno exterior de la rampa si se modifica el boceto. 
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El procedimiento para calcular una rampa se indica a continuación: 
 
Peralte (es referido a la altura de un escalón) x cantidad de escalones = (altura de rampa *  
% pendiente) = longitud de rampa 
 
Por ejemplo: 
 
0.175 x 4 = (0.70 mts x 12)  
 
Donde:  
 
0.175 es la altura promedio de un escalón de escalera 
4 es la cantidad de escalones  
12% es la pendiente que se usa como reglamento para peatones, por ejemplo 
 
Los valores para ingresar en Revit en la caja de dialogo de propiedades son: 
 

• Valor de pendiente 

• Longitud de rampa 
 
Para crear una rampa: 

1. Escoger pestaña Architecture => Panel Circulation => icono  
2. En el panel Draw escoger la opción de dibujo para la rampa (Línea o arco) 
3. En las propiedades de instancia definir el valor de ancho (casilla Width) 
4. En las propiedades de tipo definir los parámetros de dibujo para la rampa 

 

 
 
 En Shape puede escoger la forma de rampa; sólida o con espesor. 
 

5. Definir la trayectoria de la rampa 
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6. Presionar el botón  (Finish Edit Mode). 
 

 
 

Para crear Rampas usando bocetos: 
 

1. Escoger pestaña Architecture => Panel Circulation => icono  

2. En el panel Draw escoger la opción  (Boundary)  
3. Dibujar el contorno de la rampa 

 

 

4. En el panel Draw, activar la opción Raiser  (Riser) 
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5. Cerrar el contorno de la rampa definiendo las dos líneas a los extremos 

 

 
 

Barandillas (Railings) 
 
Las barandillas, aunque están vinculadas a las escaleras, rampas y pisos, se pueden 
editar y modificar de forma independiente. 
 
Las barandillas también pueden crearse sobre pisos, y pueden agregarse a las escaleras, 
pisos y rampas que han sido previamente creadas sin barandal. 
 
Cada vez que se modela una escalera o rampa, se crea una barandilla que está vinculada 
a estos elementos. Las barandillas pueden modificarse en sus propiedades. 
 
Editar las propiedades de una barandilla existente: 
 

1. Seleccionar la barandilla 
2. Cambiar la distancia sobre el borde de la escalera, en las propiedades de instancia 

en la casilla Offset from Path. 
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3. La barandilla completa se desplazará la distancia indicada sobre el borde de la 
escalera. 

 

 
 

4. Al ingresar a las propiedades de tipo, puede cambiar el tipo. 
 
Top Rail (barandal superior) 
 
Puede añadir un barandal superior y hasta dos pasamanos a un barandal.  
 
Top Rail (barandal superior) 
 
Para editar las propiedades del barandal superior (Top Rail): 
 
 

1. En el grupo de parámetros Top Rail se puede establecer la altura de la barandilla, 
definiendo la altura de la primera baranda (contando de arriba hacia abajo). 

 

 
 

 
 

El primer barandal se denomina Top Rail, y todas sus propiedades se modifican 
desde el grupo de parámetros Top Rail. 

 



153 
 

  
 

2. Al hacer clic sobre la casilla Type, se activa el icono , el cual permite ingresar a 
la propiedades de tipo del barandal superior. 

3. Primero se debe especificar el perfil a usar y la ubicación del primer barandal 
 

 
 

• Default Join: Especifica el tipo de unión para el pasamano o el barandal 
superior, como Inglete o Empalme. 

• Fillet Radius: Si se especifica una junta de empalme, este valor determina el 
radio de empalme. 

• Hand Clearance: Especifica la distancia desde el borde exterior del pasamano 
al muro, la pilastra o el pilar al que está enlazado el pasamano. 

• Profile: El perfil que especifica la forma del barandal continuo. 

• Projection: Especifica la distancia desde el borde interior del pasamano al 
muro, la pilastra o el pilar al que está enlazado el pasamano. 

• Transitions: Especifica el tipo de transición utilizado en el pasamano o en el 
barandal superior, tiene tres opciones: 

 
None. En un sistema de escaleras con un descansillo, el barandal interior 
finalizará en el mamperlán de la primera o la última huella del descansillo.  
Simple. Se utiliza cuando hay transiciones muy justas y perfiles de 
barandal complejos. 

 
Gooseneck: Se utiliza cuando hay transiciones muy justas y perfiles de 
barandal complejos. 
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4. Especificar la terminación del primer barandal tanto al inicio como al final. 
 

 
 

• En el grupo de parámetros Extension (Beginning/Bottom), se indica el estilo de 
extensión y la longitud del barandal al inicio de la escalera, rampa o piso. 

 

 
 

• En el grupo de parámetros Extension (End/Top), se indica el estilo de 
extensión y la longitud del barandal al final de la escalera, rampa o piso. 
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Handrail (pasamanos) 
 
Las barandas continuas son subcomponentes de un sistema de barandillas que se utilizan 
como pasamanos y como barandales superiores (que también se pueden utilizar como 
pasamanos). Los barandales continuos cumplen con los códigos de construcción para 
edificios públicos que, por motivos de seguridad, deben ofrecer un soporte continuo a las 
personas que utilizan una escalera de salida.  
 
Para modificar las propiedades los pasamanos (Handrail): 
 

1. Seleccionar la barandilla 
2. Ingresar a las propiedades de tipo 
3. En el grupo de parámetros Handrail 1 y 2 puede seleccionar el tipo de 

pasamanos a usar y la posición con respecto a la barandilla. 
 

 
 

4. Al hacer clic sobre el botón , se despliega el cuadro de dialogo Type 
properties, que permite definir las propiedades del pasamanos como altura y 
perfil. 
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5. Presionar el botón OK para observar los cambios. 
 

 
 
 
Barandales 
 
Se denominan también barandales no continuos y se pueden configurar como 
complemento del barandal superior y los pasamanos. 
 
Para editar los barandales: 
 

1. Seleccionar la barandilla y entrar a las propiedades de tipo 
2. En la casilla Rail Structure (No-Continuous) hacer clic en el botón Edit, 

 

 
 

3. Se despliegan los barandales adicionales que tiene la barandilla.  
 
Se puede eliminar barandales, cambiar el perfil, asignar materiales y modificar la 
altura de cada uno, en la columna Offset puede desfasar a una distancia especifica 
un barandal con respecto a la barandilla. 
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Balaustres 
 
Se puede controlar la organización de los balaustres y las pilastras en una barandilla. 
Para cada tipo de barandilla, se puede definir el patrón de balaustres, la familia de 
balaustres, la forma de enlace en la parte superior y en la base, el espaciado, el patrón de 
división y otros aspectos. 
 
Para editar los balaustres de una barandilla: 
 

1. Seleccionar la barandilla e ingresar a las propiedades de tipo. 
2. Bajo el grupo de parámetros Construction, en la casilla Baluster Placement hacer 

clic en el botón Edit… 
 

 
 

3. Existen tres secciones en el cuadro de dialogo Edit Baluster Placement.  
 

Main Patter: se configura la famila de balaustre a usar y la distancia entre cada 
balaustre a lo largo de la trayectoria de la escalera, rampa o piso. 
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4. Use Baluster Per Tread On Stairs: Cuando el recuadro que está al lado izquierdo 
de esta opción está activado, se deshabilita la configuración de la sección Main 
patter. 

 

 
 

Se debe especificar la cantidad de balaustres por huella y la familia de balaustre a 
usar. 

 
5. Posts:  Las pilastras se colocan al inicio, final o esquina de la escalera, rampa o 

piso, en esta sección se configuran las propiedades de estos elementos. 
 

 
 

• Name: Muestra el listado de la ubicación de las pilastras al inicio, esquina o 
final. 

• Baluster Family: Se debe seleccionar la familia a usar para cada pilastra. 

• Base: La opción predefinida es Host lo que indica que las pilastras están 
vinculadas al elemento sobre el cual está colocada la barandilla (escalera, piso 
o rampa) 

• Base Offset: es la longitud que se extiende la pilastra con respecto a la base 
del host. En la imagen se observa la pilastra extendida hasta el piso. 
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• Top: la opción predefinida es Top Railing, lo que indica que la pilastra está 
conectada en la parte superior al barandal superior. 

• Top Offset: es la longitud que se extiende la pilastra desde el Top. 

• Space: Es la distancia entre la pilastra y el primer peldaño de la escalera. 
 

 
 

  Offset: es el desfase del post con respecto a la barandilla. 

 
Crear barandillas 
 
Para crear barandillas sobre escaleras: 

5. Escoger pestaña Architecture =>Panel Circulation =>  (Railing) 
6. Escoger pestaña contextual Modify Pick New Host => Panel Tools => icono 

 (Pick New Host) 

7. En las propiedades de tipo  escoger: Tipo de barandilla y el desfase 
sobre el borde de la escalera. 
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8. Presionar el botón Rail Structure (Non Continuos). Para definir la altura del 
barandal editar el valor de altura que se encuentra bajo la columna Height. El ítem 
corresponde al segundo barandal de arriba hacia abajo. 

 

 
 

9. Presionar el botón Insert para agregar los nuevos barandales. 
10. Bajo la columna Height en el ítem correspondiente, debe colocar la altura de cada 

barandal 
 

 
 

11. Presionar el botón OK para aceptar los cambios. 
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12. En las propiedades de tipo, presionar el botón Baluster Placement 
13. En la caja de dialogo Baluster Placement determinar: Cuantos balaustres por 

escalón. En la sección Post se puede configurar la colocación y tipo de balaustre 
al inicio, esquina o final de la barandilla. 

 

 
 

14. Hacer clic sobre la host (escalera, rampa o piso). 
15. Usando las herramientas del panel Draw, dibujar la trayectoria del barandal. 

16. Activar la opción Preview  para observar una vista preliminar del barandal 
(se recomienda tener activa una vista 3D) 
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17. Finalizar la creación del barandal haciendo clic sobre icono  
 
Para editar el perfil de una barandilla: 
 

1. Seleccionar la barandilla 

2. En la pestaña contextual Modify Railing => panel Mode => icono   
3. Utilizando las herramiental del panel Draw o los comandos de dición realice los 

cambios requeridos en el perfil de la barandilla. 

4. Presionar el botón  (Finish) para aceptar los cambios y salir del modo de 
edición de la barandilla. 

 
 

Puertas y Ventanas 
 
Las puertas y ventanas son otro tipo de componentes en una construcción, la creación, 
manejo y modificación de estos componentes es casi el mismo. Las puertas y ventanas 
solo podrán ser creadas dentro de un componente muro, una vez seleccionado el tipo de 
puerta o ventana basta con tocar el muro básico o apilado, y es suficiente para que el 
componente sea insertado, Revit creara el hueco del muro de manera automática. 
 
Las puertas y ventanas pueden ser reubicadas en el muro de dos maneras, la primera 
seleccionando el elemento y arrastrándolo sobre el muro con el botón izquierdo del ratón 
presionado, o bien tocando el elemento en cualquier vista y modificando las cotas 
temporales que aparecen alrededor del componente. 
 
A diferencia de los muros que solo pueden crearse en las vistas de planta o en la vista 
3D, las puertas y ventanas pueden ser insertadas prácticamente en cualquier vista 
(planta, alzado, corte, 3D) 
 

  
 
Cargar familias de puertas y ventanas al proyecto 
 
Existen varias opciones para cargar familias de puertas a un proyecto. 
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1. Escoger pestaña Insert => panel Load from Library => Load Family. 
2. Escoger la librería y luego buscar la carpeta Doors o Windows. 

 

 

 
 

3. En el listado de familias, seleccionar los archivos a cargar en el proyecto o plantilla 
de proyecto. 

 

 
 

  
 

4. El listado de familias y tipos de puertas o ventanas cargadas en un proyecto o 
plantilla se pueden ver en el navegador de proyectos bajo el apartado Familes => 
Categoría Doors o Windows. 
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Puede cargar las familias de puertas y ventanas mientras está activado el comando: 
 

1. Activar el comando para colocar puertas o ventanas. 

2. En la paleta de propiedades, ingresar a las propiedades de tipo . 
3. En las propiedades de tipo, hacer clic en el botón Load… 

 

 
 

4. Escoger la librería y luego buscar la carpeta donde están las familias que se 
requiere cargar. 

5. Presionar el botón Open para cargar la familia. 
 
 
Colocación de puertas 
 
Para insertar una puerta: 
 

1. Activar la vista correspondiente, planta, alzado, corte o 3D. 

2. Escoger Pestaña Architecture =>Panel Build =>  (Door) 
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3. En caso de requerirse que la puerta incluya un Tag con el dato relacionado al 

número de la puerta (opción predeterminada), se debe activar el botón  
(Tag on Placement) 

4. En la paleta de propiedades desplegar el selector de tipos y seleccionar la familia y 
tipo de puerta a colocar. 

 

 
 

5. Verificar o cambiar las propiedades tipo, usando la opción  en la caja 
de dialogo de propiedades 
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• Presionando el botón Load, se puede cargar otras familias de puertas al 
proyecto 

• Desplegando la casilla Type, seleccionar el tipo de puerta 

• Presionando el botón Duplicar, se podrá sacar una copia del tipo 
seleccionado y realizar cambios, sobre el nuevo tipo. 

• En los parámetros de Dimensión están definidas las dimensiones del tipo 
de puerta seleccionado. 

 
6. Ubicar el puntero sobre el muro básico o apilado donde colocará la puerta y hacer 

clic en el sitio donde colocará la puerta. 
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7. En caso de haber activado la opción Tag on Placement, junto a la puerta aparece 

el Tag que en forma predeterminada muestra el número asignado a la puerta. 
 

 
 
Crear tipos de puertas en un proyecto 
 

1. Activar el comando puerta e ingresar a la paleta de Propiedades de tipo 

 
2. Es posible escoger un tipo de puerta existente, que tenga características similares 

al que se quiere crear. 
3. Hacer clic obre el botón Duplicar. 
4. Escribir el nombre del nuevo tipo y presionar el botón OK. 

 

 
 

5. Asignar las propiedades de tipo correspondientes. 
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6. Presionar el botón OK para aceptar los cambios. 
 
Modificar ubicación de una puerta 
 
Para modificar el abatimiento y distancia de la puerta sobre los muros: 
 

1. Seleccionar la puerta. 
2. Para desplazar la puerta hacer un clic sobre el valor de la cota temporal que se 

requiere cambiar. 
3. Cuando el texto se muestre en modo edición, escribir el nuevo valor de la 

distancia. 
 

 
 

4. Para cambiar la dirección del abatimiento, seleccionar la puerta y hacer clic sobre 
las flechas que indican cambio de dirección del abatimiento. 
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5. Para cambiar el lado de la bisagra de la puerta, seleccionar la puerta y hacer clic 
sobre las flechas que indican cambio de dirección de la bisagra.  

 

 
 
 
Colocación de ventanas 
 
Para colocar una ventana: 
 

1. Activar la vista requerida para colocar la ventana 

2. Escoger Pestaña Architecture =>Panel Build =>  (Window) 
3. En caso de requerirse que la ventana incluya un Tag con el dato relacionado a la 

marca del tipo de Ventana (opción predeterminada), se debe activar el botón 

 (Tag on Placement). 
 

4. En la paleta de propiedades en las propiedades escoger la familia y tipo de 
ventana en el selector de tipos. 
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5. En las propiedades de instancia, en la casilla Sill Height ajustar la altura de 
antepecho. 

 

 
 

6. Ingresar a las propiedades de tipo . 
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•  Presionando el botón Load, se puede cargar otras familias de ventanas al 
proyecto. 

• Presionando el botón Duplicar, se puede crear un duplicado del tipo 
seleccionado y realizar cambios, sobre el nuevo tipo. 

• En los parámetros de Dimensión están definidas las dimensiones del tipo 
de ventana seleccionado tales como: altura y ancho. En la casilla Default 
Sill Height se puede indicar el valor predeterminado para la altura de 
antepecho. 

 
7. Ubicar el puntero sobre el muro básico o apilado donde colocará la ventana y 

hacer clic. 
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8. En caso de haber activado la opción Tag on Placement, junto a la ventana aparece 
el Tag que en forma predeterminada muestra la marca del tipo asignada a la 
ventana. 

 
 
Modificar ventanas 
 
Se puede ajustar la ubicación de una ventana sobre el muro y la dirección del abatimiento.  
 
Para modificar la distancia de la ventana con respecto al muro: 
 

1. Seleccionar la ventana 
2. Hacer doble clic sobre el valor de la cota temporal que se requiere cambiar. 
3. Cuando el texto se muestre en modo edición, escribir el nuevo valor de la 

distancia. 
 

 
 

4. Para cambiar la dirección del batimiento, seleccionar la ventana y hacer clic sobre 
las flechas que indican cambio de dirección. 
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Crear tipos de ventana en un proyecto 
 

1. Activar el comando puerta e ingresar a la paleta de Propiedades de tipo 

 
2. Es posible escoger un tipo de puerta existente, que tenga características similares 

al que se quiere crear. 
3. Hacer clic obre el botón Duplicar. 
4. Escribir el nombre del nuevo tipo y presionar el botón OK. 

 

 
 

5. Asignar las propiedades de tipo correspondientes. 
 

 
 

6. Presionar el botón OK para aceptar los cambios. 
 
Tags de puertas y ventanas 
 
En las puertas los tags, generalmente sirven para numerar las instancias, los tags 
muestran el valor de la marca (MARK), que por defecto comienza la numeración en 1 y se 
incrementa automáticamente en 1. 
 
En las ventanas los tags, están configurados para identificar las ventanas por tipo, 
desplegando en la vista el valor correspondiente a la propiedad del tipo de marca (TYPE 
MARK). 
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Para activar la colocación del tag mientras se insertan puertas o ventanas: 
 

1. Al ejecutar el comando Door o Window, en la pestaña contextual Modify – Place 

Door o Modify – Place Window, en el panel Tag => activar icono  (Tag on 
Placement) 

 
Para colocar tags sobre puertas o ventanas: 

1. Escoger pestaña Annotate => panel Tag => icono  (Tag by Category). 
2. En la barra de herramientas de opciones, se muestran las opciones de colocación. 

Cuando la opción Leader esta activada, se despliega junto al tag una directriz que 
señala el objeto con el cual está vinculado el tag. 

 

 
 

3. Acercarse sobre el elemento a anotar y hacer clic sobre este 
 

 
   

Para colocar automáticamente tags en puertas y ventanas: 
 

1. Escoger pestaña Annotate => panel Tag => icono  (Tag All). 
2. En la caja de dialogo Tag All, activar la opción All objects in current view 
3. Activar el cuadro que se encuentra del lado izquierdo de los nombres de las 

categorías. 
 

 
 

4. Bajo la columna Loaded Tags se muestra el tipo de tag asignado a cada categoría.  
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5. Presionar el botón Apply. 
6. Presionar el botón OK para cerrar el cuadro de dialogo. 
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Componentes de mobiliario 
 
Estos elementos son usados para complementar un modelo constructivo. Las instancias 
están definidas en familias y son componentes independientes del modelo, por ejemplo, 
escritorios, sillas, cocinas etc. 
 
Para insertar un componente de mobiliario: 

1. Escoger pestaña Architecture => Panel Build =>  
2. En la pestaña contextual Modify Palce Component =>panel Mode => escoger 

icono  
3. Buscar la librería de donde se requiere sacar las familias. Por ejemplo, en la 

librería US Metric se encuentran todas las carpetas que continen componentes de 
mobiliario como: Casework, Furniture, Entourage, Planting, Speciality Equipment, 
Site, Lighting etc. Entrar a la carpeta correspondiente y escoger la familia a usar. 

4. En el selector de tipos escoger el elemento a colocar en el dibujo. 
 

 
 

5.  Antes de colocar el componente de mobiliario se puede rotar, presionando la 
barra espaciadora. El elemento de forma predeterminada rotará 90 grados, cada 
vez que presione la barra espaciadora, puede ser que tome otro ángulo, si es que 
se hace referencia a un plano de trabajo con un ángulo que no sea recto. 

6. Hacer clic en el sitio donde va a colocar el elemento. 
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Componentes de iluminación 
 
Las familias de iluminación se encuentran en la carpeta Ligting. Las luces pueden estar 
referenciadas a un plafón, muro o plano de trabajo, Las luces normalmente se colocan en 
vista de techo (Ceiling). 
 
Para colocar componentes de iluminación en techos: 
 

1. Colocar activa una vista de techo (Ceiling), observar que previamente tenga 
colocado un plafón. 

2. Escoger pestaña Architecture => Panel Build =>  
3. En la pestaña contextual Modify Palce Component =>panel Mode => escoger 

icono  
4. En caso de escoger la librería US Metric se debe buscar en la carpeta 

Ligting/Architectural las familias de iluminación, escoger cualquiera de las familias 
de luces para techos 

5. Hacer clic en el sitio donde será colocada a luz 
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Huecos 
 
El comando Opening se utiliza para abrir huecos en pisos, paredes, cubiertas y techos. 
 
Los huecos de pisos, techos y losas pueden ser seleccionados en forma vertical o 
perpendicular a la vista. Los huecos también pueden tener formas complejas, es decir se 
crean a partir de perfiles que forman áreas cerradas. 
 
Existen cinco opciones para crear huecos: 
 
By Face (Por cara) 
 
Utilice la opción Por cara cuando desee que el hueco sea perpendicular a la cara 
seleccionada 
 
Para crear huecos por cara: 
 

1. Escoger pestaña Architecture => Panel Opening => icono  (By Face) 
2. Se debe seleccionar la cara de un piso, techo o plafón. 

 

 
 

3. Usando las herramientas del panel Draw dibujar el perfil boceto con la forma que 
tendrá el hueco. 
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4. Presionar el botón  (Finish) para salir del comando aceptando los cambios. 
 

 
 
 
Hueco Vertical 
 
Se utiliza la opción Vertical cuando desee que el hueco sea perpendicular a un nivel. 
 

1. Escoger pestaña Architecture => Panel Opening => icono  (Vertical). 
2. Se debe seleccionar un piso, techo o plafón. 
3. Utilizar las herramientas del panel Draw para dibujar el boceto del hueco. 

 

 
  

4. Presionar el botón  (Finish) para salir del comando aceptando los cambios. 
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Huecos en Muros (Wall) 
 
Permite cortar huecos rectangulares en un muro recto o curvado. 
 
Para crear huecos en muros: 
 

1. Activar una vista de fachada, planta o 3D 

2. Escoger pestaña Architecture => Panel Opening => icono  (wall). 
3. Seleccionar el muro. 
4. Definir punto inicial y final sobre el muro. 

 

 
 

Abertura (Shaft) 
 
Permite crear un hueco que abarque toda la altura de un edificio (o los niveles 
seleccionados) a través de las caras de cubiertas, pisos o techos simultáneamente. 
 
Para crear huecos sobre pisos, techos y cubiertas: 
 

1. Activar una vista de planta  
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2. Escoger pestaña Architecture => Panel Opening => icono  (Shaft) 
3. En la pestaña contextual Modify Create Shaft Opening Sketch => panel Draw, 

escoger la opción de dibujo para el perfil. 
4. En las propiedades de instancia definir altura base y altura superior, o selecciones 

los niveles que abarca el hueco. 
 

 
 

5. Dibujar el perfil del hueco. 

 
 

6. Presionar botón  Finish Edit Mode, para crear el hueco. 
 
 
Para modificar un hueco: 
 

1. Activar la vista correspondiente, de acuerdo con el tipo de hueco a modificar 
2. Seleccionar el hueco 
3. En la pestaña contextual Modify Shaft Opening => panel Mode => escoger icono 

 (edit Sketch) 
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Grupos  
 
La agrupación de elementos resulta útil para crear entidades que representan diseños 
repetitivos o comunes en muchos proyectos de construcción, por ejemplo, habitaciones de 
hotel, apartamentos o plantas que se repiten.  
Todos los ejemplares de un mismo grupo que coloque siguen unas normas de 
asociatividad. Por ejemplo, puede crear un grupo con una cama, muros y ventana, y a 
continuación colocar en el proyecto varios ejemplares de ese grupo. Si modifica un muro 
en uno de los grupos, el cambio se aplica a todos los ejemplares de ese grupo; así se 
simplifica el proceso de modificación.  
 
Existen dos tipos de grupos que se pueden crear: 
 

• Grupos de modelo (Model Group): Contienen elementos de modelo. 

• Grupos de detalles (Detail Group): Contienen elementos específicos de vista, 
por ejemplo, texto y regiones de relleno. 

 
 
Para crear un grupo: 
 

1. Seleccionar todos los objetos que formarán parte del grupo. 
 

 

2. En la pestaña Modify – Multi Select => Panel Create => icono  (Create). 
3. Asignar un nombre al grupo. 

 

 
 
Cuando la opción “Open in Group Editor” está activada, se crea el grupo, y luego se abre 
automáticamente el editor de grupos. 
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4. Al hacer clic sobre cualquier elemento que es parte del grupo, se seleccionan 
todos los elementos. 

 
 
Los grupos se copian en el mismo nivel o a otros niveles usando los comandos de edición 
Copy (mismo nivel) o Copy to Clipboard (a otros niveles).  
 
Los grupos se pueden observar listados en el navegador de proyectos bajo la sección 
Groups. 
 

 
 
Modificar grupos 
 
Cuando los objetos son agrupados, estos se comportan como un solo elemento, por lo 
tanto, a los objetos de un grupo no se los puede manipular de forma independiente, a 
menos que el grupo sea editado o desagrupado. Cuando un grupo es editado, cualquier 
cambio que se realice sobre los elementos se verá reflejado en todos los grupos que son 
iguales en todo el proyecto. 
 
Al desagrupar, los objetos vuelven a ser independientes. 
 
Para editar un grupo: 
 

1. Seleccionar un grupo, en cualquier vista del proyecto. 
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2. En la pestaña contextual Modify Model Groups => panel Group => escoger icono 

 (Edit Group). 
3. Puede realizar cambios al grupo. Por ejemplo para agregar un elemento, 
4. Presionar el botón Add en la barra de herramientas Edit Group. 

 

 
 

5. Seleccionar el elemento a agregar al grupo. 
 

 

6. En el panel Edit Group presionar botón  (Finish). 
 

7. Con la opción  (Attach) se puede vincular un Grupo de detalles. 
 
 
Para eliminar elementos de un grupo: 
 

1. Presionar el botón Remove en la barra de herramientas Edit Group. 
 

 
 

2. Seleccionar el elemento a eliminar del  grupo. 
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3. En el panel Edit Group presionar botón  (Finish). 
 
Para desagrupar elementos: 
 

1. Seleccionar el grupo 
2. En la pestaña contextual Modify Model Groups => panel Group => escoger icono 

 (Ungroup) 
 
Convertir grupo modelo a un proyecto vinculado 
 
Puede convertir el grupo en un nuevo modelo o reemplazar el grupo con un modelo 
existente que esté vinculado al proyecto. Cuando selecciona un grupo se puede activar el 
comando Link que se encuentra en el panel Group, se muestran dos opciones para 
convertir: 
 

• Reemplazar con un nuevo archivo de proyecto (Replace with a new project 
file): Crea un modelo. Si selecciona esta opción, se abre el cuadro de diálogo 
Guardar grupo.  

 

• Reemplazar con un archivo de proyecto existente (Replace with an existing 
file): Sustituye el grupo por un modelo ya existente. Si selecciona esta opción, 
aparece el cuadro de diálogo Abrir.  
 

Para convertir grupo reemplazando con nuevo archivo: 
 

1. Seleccionar el grupo en el proyecto abierto 
2. En la pestaña contextual Modify Model Groups => panel Group => escoger icono  

 (link). 
3. Se despliega la caja de dialogo Convert to link. 
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4. Escoger opción Replace with a new Project file. 
5. Se abre la caja de dialogo Save Group 

 

 
 

6. En la casilla File name, escribir el nombre del proyecto. 
7. Presionar el botón Save 
8. Esto hará que se genere un nuevo proyecto RVT que contiene los elementos que 

son parte del grupo. 
9. El archivo donde originalmente fue creado el grupo se transforma en un archivo 

RVT vinculado. 
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Para convertir grupo reemplazando con nuevo archivo existente: 
 

1. Seleccionar el grupo a reemplazar en el proyecto abierto. 

 
2. En la pestaña contextual Modify Model Groups => panel Group => escoger icono  

 (link). 
 

3. Se despliega la caja de dialogo Convert to link. 
 

 
 

4. Escoger opción Replace with an existing Project file. 
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5. Se abre la caja de dialogo Abrir. 
 

 
 

6. Seleccionar un archivo RVT. 
7. Presionar el botón Open. 
8. Se reemplaza el grupo seleccionado, por el grupo que está definido en el archivo 

RVT. 
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Capítulo 8 
 

Exportación de vistas  
 
Revit permite exportar tanto vistas 2D como 3D a otros formatos de dibujo, imágenes o 
bases de datos. 
 
Las extensiones de archivos a las cuales se puede exportar información del proyecto son: 
 

• DWG de AutoCAD tanto vistas 2D como 3D 

• DGN de Microstation tanto vistas 2D como 3D 

• Tablas de cuantificación a formatos de texto 

• Imágenes y caminatas a archivos de animación (AVI) 

• El proyecto a base de datos de Microsoft Access 

• FBX para 3D Max 

• Building Site ADSK, formato de intercambio para aplicaciones de ingeniería civil 

• Formatos SAT, para intercambio con aplicaciones CAD que trabajan con sólidos 
 
Exportación a formato DWG 
 
Para exportar información desde Revit a formatos DWG: 
 

1. Escoger pestaña File => Export => CAD Formats => opción DWG. 
2. En la caja de dialogo DWG Export, en la sección Select Export Setup hacer clic 

en el botón . 

3. Para crear un formato de exportación, hacer clic sobre el icono (New Export 
Setup) y asignar  un nombre. 

4. Las opciones Export layers potions y Load layers from standars, permiten 
escoger los estándares internacionales que seusarán como base para asignar los 
nombres y colores de las capas. 

 

 
 

5. En la pestaña Layers, bajo la columna Category se muestra el listado de todas las 
categorías existentes en Revit. 

6. Bajo la columna Layer, se muestra el nombre que se asignará a la capa en 
AutoCAD. Se puede modificar el nombre de la capa y el color. 
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7. En la pestaña Solids, escoger si los objetos se exportan como sólidos o mallas. 
Esto aplica para vistas 3D. 

 

 
8. En la pestaña Units & Coordinates, escoger las unidades de medida para 

exportación. 
 

 
 

9. Presionar el botón Ok para salir del cuadro de dialogo de formatos de exportación 
10. En el cuadro de dialogo DWG Export y presionar el botón Siguiente. 
11. En la casilla Tipo de archivo, escoger la versión de AutoCAD en la cual se quiere 

guardar el archivo. 
12. Cuando la opción Export views on sheets and links as external references está 

activa, en AutoCAD las vistas se colocan sobre layouts y el dibujo (del entorno 
modelo) queda ligado como una referencia externa. 
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13. Presionar el botón OK, para generar el archivo DWG. 
 
Exportar a formatos DWF 
 
Para imprimir a formatos DWF: 
 

1. Escoger la pestaña File => Export =>  
2. Puede crear un set de impresión que incluya varios planos o vistas. 

 
 

3. Asignar un nombre al set 
4. En el listado, seleccionar las vistas o planos a exportar al DWF. 

 
Los archivos DWF generados por Revit, se visualizan con el programa Desing Review 
igual que otros archivos DWF generados por otras aplicaciones de Autodesk, también se 
les puede colocar marcas de revisión que luego podrán ser cargadas en las vistas de 
plano en Revit. 
 

 
 
 


